The information contained within this document regarding KeyTag Analyzer software usage is intended as a guide and does not constitute a declaration of performance. The information contained in this document is subject to change without notice. Unless otherwise noted, the example companies, organizations, e-mail addresses and people depicted herein are fictitious, and no association with any real company, organization, e-mail address or person is intended or should be inferred. Complying with all applicable copyright laws is the responsibility of the user.

No representation or warranty is given and no liability is assumed by KeyLog Recorders with respect to the accuracy or use of such information or infringement of patents or other intellectual property rights arising from such use or otherwise.

Copyright © 2006-2008 KeyLog Recorders. All rights reserved.
www.keylog.nl
## Contents

### Introduction 4

### Installing the software 5

- System requirements .......................................................... 6
- Getting a copy of the software ............................................ 7
- The installation process ...................................................... 8
- Starting the software ........................................................ 9

### Quick Start Guide 12

- Connecting the Interface .................................................. 12
- Using the KeyTag with the Interface ................................. 14
- Get a KeyTag ready for use .............................................. 15
  - Welcome ........................................................................ 16
  - Locate KeyTag(s) download and save relevant data ........ 17
  - Configure KeyTag(s) for next use ................................. 19
  - Prepare KeyTag(s) for next use .................................... 20
- Starting and using the KeyTag .......................................... 21
- Retrieve information from KeyTag ................................. 23

### Preparing KeyTag(s) for use 25

- Getting a KeyTag ready for use ...................................... 26
- Restricted Access Requirements .................................... 27
- Preparing KeyTag for next use ....................................... 28
- Alert Processing ............................................................... 31
- Verify Access Password .................................................. 34
- Pre-start data collection .................................................. 35
- Continuous operation ...................................................... 35
- Working with batches of KeyTags .................................... 36
- Getting the best from your KeyTag ................................. 37
- Prolonging battery life ..................................................... 38

### Results from KeyTag 41

- Getting results from KeyTag .......................................... 42
- Understanding the results ............................................... 43
- Inspecting the information at close range ....................... 44
- Manual scaling of the chart ............................................ 48
- Chart annotations ............................................................ 49
- Chart subtitle ................................................................. 51
- Combining charts onto a single chart ............................. 53
  - Shifting chart start times ............................................. 54
  - Changing Chart Colours ............................................. 56
  - Aligning Charts .......................................................... 57
  - Special Chart Tabs ...................................................... 57
Contents

Toolbar commands.................................................................105
Print preview toolbar ............................................................106

Working with Networks .........................................................108
Distributing software to workstations ................................108
Restricting what users can do ..............................................109
How users log on ...............................................................110
How users change their password .......................................111

Getting more information ...................................................112
Getting updated software ....................................................112
Finding your software version ............................................114
Getting more help .............................................................115

Appendix .............................................................................116
Troubleshooting ...............................................................116
Finding your computer specifications .................................118
Resolving USB Driver Problems ..........................................124
Checking the installation of the USB driver ......................124
USB driver installation through software installation ..........130
Manual USB driver installation on Windows XP ................132
Manual USB driver installation on Windows 2000 ...............136
Manual USB driver installation on Windows 98 or Me .........142
Sensor Responsiveness .......................................................147

Index ..................................................................................149
This guide will take you through the relevant steps so that you will be able to make the most of your KeyLog Recorders products. The guide is structured into chapters that will guide you through the process of installing the software, using the KeyLog Recorders products and lastly some of the options that are available to you for making your efforts and experience of using the software as efficient, effective and pleasant as possible.

The chapters in this guide are placed in an order that you will need to follow in order to successfully use the KeyLog Recorders products first time. Experienced users of the software may choose to skip the first two chapters. However, if you are about to use a newer version of a KeyTag and/or Interface Cradle, we recommend you at least skim the installation chapter for any relevant changes that should be performed prior to using your new version of KeyTag hardware.

This guide covers all the features included in version 1.7 of the KeyTag Analyzer software. The chapter "Finding your software version" included later in this guide will help you through the process of finding out what version of the KeyTag Analyzer software is being used and will help explain and determine if this version of the guide refers to the version of the software being used. The chapter "Getting updated software" included later in this guide will help you through the process of obtaining an updated copy of the software. Therefore, if you find a feature described within this guide that does not appear in your software and/or a feature within the version of software being used that is not described in this guide, then we recommend you obtain a newer version of the software and/or a newer version of this guide. You may obtain a free online copy of the latest version of this guide from the KeyLog Recorders Internet site, www.keylog.nl.

Although this guide includes all the relevant information to install and use the product range supplied by KeyLog Recorders, there are at times an expectation that the reader is familiar with using their computer and the Windows® operating system. If a feature of the software is specific to a version of the Windows® operating system, the guide will indicate appropriately for you the relevant differences.

Feedback, positive or negative, about the software, the KeyLog Recorders products and/or this guide is welcome. If you believe the products could be improved, you are welcome to send us your comments and we will do our best to include the improvements in a future release.
To make use of your KeyTag you will need to first install the software on your computer. This will allow you to prepare your KeyTag(s) for use, retrieve the readings the KeyTag(s) have recorded, and analyze the data. This chapter will take you through the steps necessary to successful install the software on to your computer so you can begin using your KeyTag(s). The process of installing the KeyTag Analyzer software should be very familiar to users that have previously installed other software and therefore some experienced users may choose to only skim read or entirely skip this chapter. If you are new to using a computer and/or unsure about installing the software, we recommend you read the remainder of this chapter.

In This Chapter

System requirements .............................................. 6
Getting a copy of the software ............................... 7
The installation process ........................................ 8
Starting the software ............................................ 9
System requirements

To ensure that the software will be able work with your computer, the following lists the minimum specifications required:

- Pentium II 233MHz processor
- 64MB RAM
- 20MB free disk space
- Windows NT, Windows 2000, Windows XP, Windows VISTA
- Internet Explorer 5.0 or later
- 1 available serial port and/or 1 available USB port
- 800 x 600 screen resolution
- 256 screen colors.

The recommended specifications are:

- Windows 2000, Windows XP, or later
- Internet Explorer 6.0 or later
- 65535 (16bit), or more, screen colors.
- 1024 x 768, or higher, screen resolution.

If you are unsure of what your computer specifications are, please read the appendix "Finding your computer specifications", which will help you locate the relevant information.
Getting a copy of the software

The software is available for download from the KeyLog Recorders Internet site, www.keylog.nl. KeyLog Recorders does not charge for the download of the KeyTag Analyzer software or for the updates to the KeyTag Analyzer software. You are welcome to distribute copies of the KeyTag Analyzer software provided it is distributed in the packaged format as originally downloaded from the KeyLog Recorders Internet site.

When you visit the KeyLog Recorders Internet site, follow the software navigation links to obtain a download link for the latest version of the KeyTag Analyzer software. The request to download KeyTag Analyzer software from the KeyLog Recorders Internet site will result in an email automatically being sent to you with the download link for the latest version. To begin the actual download of the software process, click on the link provided in your email, and your email software will prompt you to save or open the file.

![File Download]

Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save the file.

- File name: keytag_analyser_11r2.exe
- File type: Application
- From: www.keylog.nl

⚠️ This type of file could harm your computer if it contains malicious code.

Would you like to open the file or save it to your computer?

[Open] [Save] [Cancel] [More Info]

Always ask before opening this type of file

We recommend choosing the option to save the file to your disk and to save the file to your desktop. If you are an experienced user you may wish to save the file to a different folder of your choosing. Once the installation process has been completed, this file can be safely deleted, as it is not required for using the software.

Only one file needs to be downloaded to enable installation of the software on your computer. Once the relevant installation file has been downloaded to your computer, you only have to open the file to begin the installation process.
The installation process

To install the KeyTag Analyzer software, first you need to locate the installation file that was downloaded from the KeyLog Recorders Internet site. To begin the installation process open the installation file, which is typically performed by double clicking the left mouse button.

Tip: Double clicking a mouse button, implies the user clicks the same mouse button in quick succession.

The installation process will guide you through the relevant steps to correctly and successfully install the software. If you have installed any other software, you should find the installation process familiar. To proceed through each step of the installation process, click the "Next" button. If you want to change a previous step you can click the "Back" button. When the process is ready to be completed, clicking the "Finish" button, when it appears, will finish the installation process. If you want to stop installing the software, click the "Cancel" button.

We recommend you leave all options to their default setting, especially if you are unsure of what option to select or what the actual implications are if the option was to be changed.

During the installation process, a window similar to the following picture may appear. This is part of the process of installing the driver for the USB Interface. Clicking on the "Continue Anyway" button will allow the driver to be successfully installed. The chapter "Resolving USB Driver Problems", included later in this guide will guide you through the necessary steps to successfully install the driver for the USB Interface if the "STOP Installation" button was clicked.

![Hardware Installation]

The software you are installing for this hardware:
USB Interface

has not passed Windows Logo testing to verify its compatibility with Windows XP. [Tell me why this testing is important]

Continuing your installation of this software may impair or destabilize the correct operation of your system either immediately or in the future. Microsoft strongly recommends that you stop this installation now and contact the hardware vendor for software that has passed Windows Logo testing.

[Continue Anyway]  [STOP Installation]
Starting the software

At the conclusion of the installation process, the final screen will provide you with an option to immediately start the KeyTag Analyzer software. If the option "Start KeyTag Analyzer after finished" is not visible, then you require other newer software, for example a newer version of Microsoft Internet Explorer, to be installed prior to the KeyTag Analyzer software being able to successfully start.

The installation of the KeyTag Analyzer software will also provide you with two simple methods to start the KeyTag Analyzer at a later time:

1. A "Shortcut" on the desktop, which you can double click to start the software.
2. A "Shortcut" in the "Start" menu system.
If you are using Windows XP, you may need to click on the "All Programs" item to locate the "KeyTag Analyzer" shortcut, like in the following picture.
If you are not using Windows XP, you will find the "KeyTag Analyzer" shortcut in the "Programs" menu, in a similar location to the following picture.
Quick Start Guide

You’ve got the software installed on your computer and now you want to use the KeyTag, see how it goes and what it can do. This chapter will briefly cover the steps involved to get your KeyTag ready to use, how to get it started and then retrieve the recorded information out of the KeyTag. The subsequent chapters will explain in more depth these steps and the various options available to you.

In This Chapter

Connecting the Interface ........................................ 12
Using the KeyTag with the Interface........................... 14
Get a KeyTag ready for use ...................................... 15
Starting and using the KeyTag ..................................... 21
Retrieve information from KeyTag ............................. 23

Connecting the Interface

There are two types of the Interface Cradle available. The first connects to the computer’s serial (RS232) communications port and the other connects to the computer’s USB (Universal Serial Bus) communications port. Although there may be multiple connectors on the computer for each of these types of communications ports, the shape of each is unique and therefore it is not possible to connect the Interface Cradle to the wrong type of communications port. The software supports the connection of multiple Interface Cradles at the same time and therefore as many serial and/or USB Interface Cradles as are needed and the computer supports may be connected.

The connectors for the serial (RS232) communications ports typically look like the following picture.
Serial (RS232) communication ports can be typically found at the rear of the computer and there are usually at most two ports installed on a single computer. Most serial Interface Cradle connectors will have screws included on the plug and as such we recommend that these are tightened when the connector is plugged in so that it does not accidentally pull out during usage.

The connectors for USB devices typically look like the following picture.

![USB ports on the computer and USB Interface connector](image)

Connectors for USB devices and the sockets on the computer where USB devices are plugged in will often display a USB logo nearby to help them be identified. Example pictures of the USB logos that may appear are:

![USB logo](image)

The sockets for the USB communication ports are typically located at the rear of the computer. In some computers there may also be two or more USB communication ports located on a front panel of the computer and/or on the top of the computer case. Please ensure that the software has been installed prior to connecting the USB Interface Cradle to the computer as the software installation also installs the drivers required to successfully connect and use the USB Interface Cradle. If you experience problems getting the software to find and identify a connected USB Interface Cradle then there may have been a problem during the installation of the software with the installation of the drivers that the USB Interface Cradle requires. The subsequent section resolving **USB driver problems** will guide you through the steps necessary to resolve any problems with getting USB Interface Cradles working on the computer.

If the computer is using the Windows NT® operating system, a USB Interface Cradle will not be able to be used, as Windows NT® does not support USB devices.
Using the KeyTag with the Interface

The KeyTag fits into the Interface Cradle slot with the front of the KeyTag facing towards the front label of the Interface Cradle with the contacts on the reverse side, similar to the following picture.

If you look into the Interface Cradle slot, you will be able to see where the contacts connect with the matching contacts in the Interface Cradle.

When placing the KeyTag into the Interface Cradle slot, you should be able to feel a very slight resistance as the contacts "grab" the KeyTag. This is normal. Removal of the KeyTag will cause a slight clicking noise as the contacts snap back into their "unloaded position".

If the KeyTag has readings stored within its memory, the software will automatically start to download the data and will also display an animated picture during the download process, similar to the following picture.

The download process can be stopped by clicking on the "Cancel" button below the download animation or by pressing the "Esc" key.
Get a KeyTag ready for use

To begin the process of preparing a KeyTag to record information, first click the KeyTag icon (I) that is located on the toolbar, which will start the KeyTag wizard.

The KeyTag wizard performs two distinct tasks:

1. It finds the communication port (USB and/or Serial) that the KeyTag is attached to through the Interface Cradle and retrieves the data that is stored within the KeyTag, and

2. It allows the KeyTag that is currently connected and in the Interface Cradle to be prepared for its next use.

The wizard is a key part of the software that is used for each of the steps.

In This Section

Welcome ...............................................................16
Locate KeyTag(s) download and save relevant data .17
Configure KeyTag(s) for next use .........................19
Prepare KeyTag(s) for next use ............................20
Welcome

First the Wizard has a welcome screen (this is "1" on the Action List). This asks you to make sure you have not neglected to place the KeyTag firmly in the Interface Cradle.

The Wizard is responsible for certain "Action Steps" and these are clearly listed at the left in the wizard window.

To get to the next screen, click on the Next button and the next wizard screen will appear. The green arrow will indicate you have moved to Step 2.
Locate KeyTag(s) download and save relevant data

The software will locate the KeyTag products for you, download the relevant information and save the information to disk. Please wait while this process completes. When completed you can press the Next button to configure the KeyTag products for their next use, or press the Finish to exit this process.

<table>
<thead>
<tr>
<th>Location</th>
<th>Interface Model</th>
<th>KeyTag ID</th>
<th>Readings</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>KTJ/USB</td>
<td>0004310317</td>
<td>455</td>
</tr>
<tr>
<td>USB</td>
<td>KTJ/USB</td>
<td>Not Found</td>
<td></td>
</tr>
<tr>
<td>COM1</td>
<td>KTJ/RS232</td>
<td>0008110337</td>
<td>7906</td>
</tr>
<tr>
<td>COM2</td>
<td>Not Found</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

100%
In this screen you will see one of the following pictures next to each of the items in the list:

- (no picture) indicates the software is still using this communications port.
- Data was successfully retrieved from the KeyTag and stored/saved to disk.
- Data was successfully retrieved from the KeyTag but there was no need to save the information to disk.
- The software was unable to detect an Interface Cradle connected to the communications port or was unable to detect a KeyTag in the Interface Cradle.
- The KeyTag is a single use logger and cannot be prepared for use again and should therefore be returned to the supplying distributor or agent once you have finished with the KeyTag. You will still be able to continue to retrieve information stored within the KeyTag.

The KeyTag should be almost instantly recognized by serial number and the number of readings. It is possible to have and use more than one communication port at a time and if so, the wizard will find all the KeyTags.

The communication ports that are not in use (the ones that initially are reported with the mark) can be removed from view by selecting an option. You don't have to do that now, but you can do it later to clean up the "wizard window" appearance.

To get to the next screen, click on Next > and the third wizard step screen will appear. The software will automatically proceed to the next wizard step, as if the user clicked on Next >, if each of the Interface Cradles detected have a KeyTag detected in them and the information within the KeyTag was successfully retrieved.
Configure KeyTag(s) for next use

The options are available so you have appropriate control over the way the KeyTags will behave and store data for the upcoming period of recording. These options are explained in more detail in the chapter "Preparing KeyTag for use". Click Next > to record the configuration data and you will see the final confirmation screen.
Prepare KeyTag(s) for next use

The last Wizard screen involves sending the new configuration data to each KeyTag to prepare them for their next use. While the software is sending the new configuration data to each KeyTag the top of the window will look similar to the following picture. The process of sending the new configuration data to each KeyTag should take less than 20 seconds in total to complete.

Once the software has finished uploading the updated configuration information into each KeyTag, the window displaying the progress will look similar to the following picture.
In this screen you will see one of the following pictures next to each of the items in the list:

- (no picture) indicates the KeyTag is still in the process of being prepared for its next use.
- ✓ The KeyTag was successfully prepared for its next use.
- ✗ The KeyTag failed to be prepared for next use. Press again to try again.
- 📈 The battery within the KeyTag is low and is unlikely to have enough capacity to record all the data you want during its next use. In this situation the KeyTag should no longer be used.

When all KeyTags have finished receiving their new configuration data, click close to close the wizard. Your KeyTag(s) are now ready to be started and used.

Please note that the automatic download feature is disabled in this screen. If you use the button to configure a different KeyTag, you may update the configuration of a KeyTag with unsaved data.

**Starting and using the KeyTag**

Once a KeyTag has been successfully configured for use it is ready to be started. There are two discrete methods available to start a KeyTag recording, which are selected during configuration. These start methods are explained in more detail in the chapter "Preparing KeyTag for use".

1. By pressing and holding the START MARK button on the KeyTag until both the OK and Alert lights alternately flash on and off.
2. By waiting until the date/time defined during configuration is reached, at which time recording will automatically commence. Pressing the START MARK button will have no effect until recording has commenced.
You can also have the KeyTag record an "inspection" mark at any time while it is recording, simply by pressing and holding the START MARK button on the KeyTag until both the OK and Alert lights flash on and off at the same time. You may have the KeyTag record as many inspection marks as you want while it is recording, however only one inspection mark can be recorded per reading. In other words, if your KeyTag is configured to take readings at 15 minute intervals, inspection marks can be recorded at intervals of 15 minutes or more. If the KeyTag has finished recording then pressing the START MARK button will have no effect until after the KeyTag has been prepared for next use.

Once the KeyTag has started recording (either via Start button or date/time start) the Alert and OK indicator lights operate in the following manner:

Red 'Alert' light: Flashes every 4 seconds if a configured alert condition has been met and/or exceeded.

If an alert condition is still present at the end of recording then the Alert light will continue to flash at the same rate.

Green 'OK' light: Regularly flashes every 4 seconds while recording is active to indicate that no alert condition is present.

If recording is complete and no alert condition is present then will flash regularly every 8 seconds.

Only flashes if no alert condition is present.
Retrieve information from KeyTag

When you are ready to view the recordings that are stored within the KeyTag, just place the KeyTag into the Interface Cradle as before. If the KeyTag is still recording when you go to retrieve the readings it will continue to record without interruption so you will be able to download again later if you choose.

If the KeyTag has readings stored within its memory, the software will automatically start to retrieve a copy of the recording contained within the KeyTag and will also display an animated picture during the download process, similar to the following picture.
Once the readings have been successfully retrieved from the KeyTag(s), the software will display the information for you. The chapter "Results from KeyTag" explains in more detail the information that is displayed to you as a result of retrieving the recorded readings from KeyTag(s).
Before you can use a KeyTag to monitor and record environmental conditions you must first prepare it for use. The process of preparing a KeyTag for use allows you to define a number of parameters, including:

- How long it should record the environmental condition for, so that you can be assured that it will record for the duration of time required. For example, if you want it to monitor a shipment that will take 10 days to deliver, you will be able to make sure it will record the humidity and/or temperatures throughout the entire 10 day period.
- How often it should record the environmental conditions.
- Under what conditions it should display an alert. An alert indicates when the environmental condition being recorded is not within set limits.

This chapter explains how to prepare a KeyTag for use and what the options mean.

In This Chapter

Getting a KeyTag ready for use...............................26
Restricted Access Requirements..............................27
Preparing KeyTag for next use ...............................28
Alert Processing .....................................................31
Verify Access Password ...........................................34
Pre-start data collection ..........................................35
Continuous operation .............................................35
Working with batches of KeyTags............................36
Getting the best from your KeyTag .........................37
Prolonging battery life ............................................38
Getting a KeyTag ready for use

There are two ways to prepare a KeyTag for use, both of which will achieve the same result. Once a KeyTag has been through the configuration process to get it ready for next use, any readings previously recorded will no longer be available for retrieval.

1. Click the KeyTag icon ( anomalously an image of a key with a key-shaped icon) on the toolbar or the "Wizard..." menu item located in the KeyTag menu.

![KeyTag Analyzer dialog box with menu options](image)

This is the safest option, as it will retrieve any readings that are stored within the KeyTag and save them to disk before getting the KeyTag ready for next use. This option is useful when you are unsure whether or not the readings stored within the KeyTag have been previously retrieved and saved to disk.

2. Click the "Configure..." menu item located in the KeyTag menu.

This is the quickest option, as it does not involve the step that retrieves any readings that are stored within the KeyTag. This option is useful when you know you have previously retrieved the readings or you no longer need a record of the readings that are currently stored within the KeyTag.

The wizard will appear once you have selected the option of your choice to guide you through the necessary steps to prepare a KeyTag for next use. While the wizard is visible the “Automatic download” feature will be disabled.
Restricted Access Requirements

Every KeyTag supports an option that, when enabled, results in users being required to provide the correct password to gain further access to the KeyTag. When the restricted access option is enabled, a window similar to the following picture will be displayed allowing the user to enter the correct password.

![Restricted Access Window]

The relevant process and/or wizard will only continue successfully if the correct password is supplied by the user. Passwords are case sensitive and therefore the passwords "Bob" and "bob", for example, are different.
Preparing KeyTag for next use

The "Configure KeyTag(s) for next use" step provides you with all the options that can be configured to effect how a KeyTag records data during its next use. Once the changes within this screen have been made, if any, click Next to send the configuration information to the KeyTag(s).
The following table describes each configurable option that is permitted to change.

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>This can be used for identification of the load in transit to be monitored, or simply an identifier that describes the purpose of the monitoring. Bill of Loading information, Shipper, commodity, contact name and other relevant information can be placed here.</td>
</tr>
<tr>
<td>Start method</td>
<td>This is used to determine how/when the KeyTag will start recording its next set of readings. When the Push-button option is selected, the KeyTag will start recording when the START MARK button has been pressed and held until both the OK and Alert lights alternately flash on and off. If pre-start recording is enabled, the KeyTag will start logging pre-start readings immediately (see section “Pre start data collection”). When the Date/Time option is selected, the KeyTag will automatically start recording at the date/time defined in the subsequent field. Pressing the START MARK button prior to the start date/time will have no effect. There will be no pre-start readings recorded prior to the start date/time. Note: When using the Date/Time start option, the earliest start time that can be selected is two minutes after the current time. This delay allows you to complete the remaining configuration options and gives the software enough time to configure the KeyTag before it starts.</td>
</tr>
<tr>
<td>Enable pre-start logging</td>
<td>Pre-start logging is a feature that protects the recording in the event of a failure to actually press the START MARK button to initiate the recording. It is an insurance policy against the loss of critical data. This is almost always checked for transit monitoring applications. This option is further explained in the section “Pre start data collection”.</td>
</tr>
<tr>
<td>Record readings continuously, overwrite oldest when memory full</td>
<td>This is what is called a &quot;data wrap&quot; in which the recorder just keeps writing data to memory. It is a &quot;moving window&quot; of data. For example, this is useful for fixed base MKT monitoring with the interval set to one year, so that the current &quot;yearly MKT&quot; can always be in the memory of the KeyTag. If this option is selected, the user will be &quot;opted out&quot; of the next two options. This option is further explained in the section “Continuous operation”.</td>
</tr>
<tr>
<td>Record readings so that:</td>
<td>If this is selected, the logger stops logging when the number of data points has been gathered and stored in memory that spans at least the number of days specified below. When this option is selected, the following two options will determine the number of data points over the span of time that will be recorded.</td>
</tr>
<tr>
<td>Readings recorded will span at least X days</td>
<td>If you know how long you want to record, the Configuration screen will automatically set the number of readings to be collected at a particular interval. This setting will only have an effect if the above option “Record readings so that:” is selected.</td>
</tr>
<tr>
<td>Number of readings to record X maximum is Y</td>
<td>This data box will display the calculated number of readings if you select a time span and an interval. Alternatively, you can select the number of readings desired, and the time span will be altered based on the interval. If this is selected, the logger will stop logging when the number of readings has been gathered and stored in memory. &quot;Y&quot; represents the maximum number of readings the KeyTag can store, however with a selected interval and a selected time span, you may not need to use all of the available data space. This setting will only have an effect if the above option &quot;Record readings so that:&quot; is selected.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Record a reading every X</td>
<td>This determines how frequently the KeyTag records the environmental humidity and/or temperature into its internal memory.</td>
</tr>
<tr>
<td>Begin recording after a delay of X</td>
<td>Determines how long after the START MARK button on the KeyTag has been pressed that it will actually begin to record the environment humidity and/or temperature. This feature is useful for example, when the KeyTag could falsely trigger an alert because the environmental conditions it is being started in is quite different to the environmental conditions to be monitored. If pre-start logging is enabled, the KeyTag will continue to record pre-start readings during this delay.</td>
</tr>
<tr>
<td>Enable the OK (Green) indicator</td>
<td>This determines whether or not the green light should function while the KeyTag is recording after being started.</td>
</tr>
<tr>
<td>Humidity / Temperature</td>
<td>These tab controls will allow the humidity and temperature alert conditions to be configured independently. These tab controls will only appear when configuring a KeyTag that has a humidity and a temperature sensor. If the KeyTag has only one sensor then the following alert conditions will apply to that sensor.</td>
</tr>
<tr>
<td>Configure requires a password</td>
<td>This feature allows the user to define a password that must be provided to configure the KeyTag next time. If this option is enabled and the password changes, the user will be required to verify the new password when the wizard progresses to the next step. Passwords are case sensitive and therefore the passwords &quot;Bob&quot; and &quot;bob&quot;, for example, are different.</td>
</tr>
<tr>
<td>Download requires a password</td>
<td>If this option is enabled, the KeyTag's recorded data can only be downloaded after entering the correct password. <strong>Note:</strong> Only one password can be provided for each KeyTag. The same password applies to the Configure and Download actions.</td>
</tr>
</tbody>
</table>

If the battery within the KeyTag is detected to be low and therefore not recommended for further use, the software will display a warning to you in the top right corner, like the following example.

![Warning Message]

**User ID:**

- Enable pre-start recording
- Record readings continuously, overwrite old ones when memory full

**Warning:** *KeyTag battery low*
Alert Processing

The KeyTag can display a visual alert as well as indicate in the software whether or not certain conditions have been met. Please note that matching these to known conditions of interest in your monitoring program may require some information about the effects of exposure to different durations of out-of-range humidity and/or temperatures.

As with the other logging parameters these are adjusted in the "Configure KeyTags for use" screen.

The following table describes each configurable option.

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable the Alert (Red) indicator when</td>
<td>This determines whether or not the red light should activate when an alert condition has been detected. An alert occurs when one or more of the conditions described below have been met. When an alert condition has occurred, this indicator will flash at a regular interval.</td>
</tr>
<tr>
<td>Readings below X or above Y</td>
<td>You can set the upper threshold limit and lower threshold limit by entering the appropriate information in the boxes. If the reading does not go below X or above Y then the alert indicator will not activate. Charts will display alert readings according the settings made in the KeyTag Analyzer</td>
</tr>
<tr>
<td>After X consecutive alert readings (W minutes)</td>
<td>This feature allows the user to specify the condition that will trigger an alert. Note that the number of minutes shown will depend on the number of alert readings you enter into the box AND the recording interval already specified. For example, if X is 3 and two readings are above the upper threshold limit but the subsequent reading is below the upper threshold limit and still above the lower threshold limit then the alert indicator will not activate. Maximum value is 256, minimum is 2.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>After X alert readings have occurred (W minutes)</td>
<td>This feature allows the user to add an additional “or” type of condition to trigger an alert. You may want to add up the total number of alert readings in addition to or instead of consecutive readings. Maximum value is 256, minimum is 2. An example of the use of this feature is included later in this section.</td>
</tr>
<tr>
<td>Leave alert indicator enabled even if readings return within alert range</td>
<td>If this option is enabled then the alert indicator will remain active, even if the current reading does not meet the alert conditions specified by the previous controls. If this option is disabled then the alert indicator will remain active only if the current reading meets the alert conditions specified by the previous controls.</td>
</tr>
<tr>
<td>Clear and reset alert when START MARK button pressed</td>
<td>This feature will turn off any active alert whenever the START MARK button is pressed on the KeyTag. It will also reset the internal alert counters such that it would be as if no alert condition had occurred at all while the KeyTag was recording. If however, the KeyTag has finished recording all the readings, pressing the START MARK button will not clear and reset any active alert. If the KeyTag being configured does not support this feature, this feature will be disabled and therefore its setting cannot be changed.</td>
</tr>
</tbody>
</table>

**Example:**

You wish to configured a KeyTag so alert conditions are indicated if 5 continuous readings are out-of-range or 7 total readings are out-of-range. Alert parameters should be set as follows:

- After [ ] consecutive alert readings (5 minutes)
- After [ ] alert readings have occurred (7 minutes)
- Leave alert indicator enabled even if readings return within alert range
This table shows how different conditions would result in the Alert Indicator flashing or not:

<table>
<thead>
<tr>
<th>What the KeyTag recorded</th>
<th>What the KeyTag indicated</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 readings out-of-range, return to normal, 2 readings out-of-range, return to normal</td>
<td>Neither alert condition is met. The maximum number of consecutive out-of-spec readings is only 2 (5 required.) The total out-of-range events equals 2 + 2 + 2 = 6. The alert condition is 7 total, so the alert does not go off.</td>
</tr>
<tr>
<td>2 readings out-of-range, return to normal, 2 readings out-of-range, return to normal</td>
<td><strong>No Flashing Red Alert Indicator</strong></td>
</tr>
<tr>
<td>4 readings out-of-range, return to normal, 4 readings out-of-range</td>
<td>The first alert condition is not met, as the maximum number of consecutive out-of-spec readings is only 4 (5 required.) The second alert condition however IS met since the total out-of-range events equals 4 + 4 = 8. The alert condition is 7 total. so the alert DOES go off.</td>
</tr>
<tr>
<td>4 readings out-of-range, return to normal, 4 readings out-of-range</td>
<td><strong>Flashing Red Alert Indicator</strong></td>
</tr>
<tr>
<td>4 readings out-of-range, return to normal, 2 readings out-of-range</td>
<td>Neither alert condition is met. The maximum number of consecutive out-of-spec readings is only 4 (5 required.) The total out-of-range events equals 4 + 2 = 6. The alert condition is 7 total, so the alert does not go off.</td>
</tr>
<tr>
<td>6 readings out-of-range, return to normal</td>
<td>The second alert condition is not met, as the total out-of-range events equals 6 (7 required.) The maximum number of consecutive out-of-spec readings however is 6, the alert condition is 5 consecutive readings, so the alert DOES go off.</td>
</tr>
<tr>
<td>6 readings out-of-range, return to normal</td>
<td><strong>Flashing Red Alert Indicator</strong></td>
</tr>
</tbody>
</table>
Please note following special conditions:

1. If you wish an alert to be indicated on the first reading that is recorded out-of-spec, place a tick in the box next to "Enable the Alert (Red) indicator when" and remove the ticks in both boxes next to the "After X consecutive alert readings" and "After X alert readings have occurred".

2. You can not enter a number into the "After X consecutive alert readings" field which is larger than the number in "After X alert readings have occurred", since the latter alert condition would always be met first.

3. Similarly, you can not enter a number into the "After X alert readings have occurred" field which is smaller than the number in "After X consecutive alert readings". The software will adjust field values as appropriate.

---

**Verify Access Password**

When configuring a KeyTag for its next use, if the user enables the "Configure requires a password" option and/or changes the password to restrict access to the KeyTag, then the user is required to verify the password to be defined before it will be stored in the KeyTag. The window that will appear to verify the password will be similar to the following picture.

![Verify new password window](image)

Once a password has been stored in the KeyTag, further access to it can only be achieved by providing the correct password. Therefore, if a password is forgotten further access to the KeyTag will not be possible. Passwords are case sensitive and therefore the passwords "Bob" and "bob", for example, are different.
Pre-start data collection

The KeyTags support a feature called "pre-start logging", which can be selected during configuration.

When pre-start logging is enabled the KeyTag will automatically start logging as soon as configuration is completed. It will record at the same sampling interval as defined in the configuration and will continue to record until the user starts the KeyTag by pressing the START MARK button on the KeyTag. Once the KeyTag has been started, it will record as per the configuration settings. While the KeyTag is recording pre-start readings the Alert LED on the KeyTag will not activate if an alert condition is detected.

Pre-start logging is useful as a fail-safe recording setting so if the KeyTag is not started at the appropriate time, the readings will still be available to view later.

When the readings are retrieved from the KeyTag, any pre-start readings will be identified as pre-start readings so the user can quickly identify the readings recorded before and after the KeyTag was started.

All KeyTags have a finite amount of memory to store the readings it records. Therefore, while the KeyTag is recording pre-start readings the KeyTag will operate in its 'continuous operation' mode, which is explained further in the section "Continuous operation". Once the memory within the KeyTag is full the oldest pre-start reading will be overwritten with the latest reading recorded, regardless of whether the reading recorded is a pre-start reading or a reading to be recorded after the KeyTag has been started.

Continuous operation

All KeyTags have a finite amount of memory to store the readings that are recorded. When the KeyTag is recording readings continuously it will not stop once the memory within the KeyTag is full of readings. Rather it will replace the oldest reading stored within the KeyTag with the latest reading so that only the most recent readings are maintained in the KeyTag memory.
Working with batches of KeyTags

You may find that at some stage you need to perform a similar task on multiple KeyTags, whether it is retrieving readings stored within the KeyTags and/or preparing them for their next use. The KeyTag Analyzer software has been designed to make the effort involved with multiple KeyTags as simple as possible.

To retrieve a copy of the recorded readings stored within multiple KeyTags, simply insert each KeyTag to download into the Interface cradle. The software will then automatically retrieve the recorded data from the KeyTag, save it to disk and then display the information for you. Therefore, you will be able to retrieve the recorded readings stored from within one or more KeyTags without needing to interact with the software and/or computer.

To prepare multiple KeyTags for use you can use the "Wizard..." or the "Configure..." wizard, available in the "KeyTag" menu, depending on whether or not you want to retrieve and save a copy of any readings recorded within the KeyTags you are about to use. Simply prepare the first KeyTag(s) as per usual and at the conclusion of the last step remove the KeyTag(s) from their Interface Cradle, place the next KeyTag(s) to be prepared for their next use into an Interface Cradle and click [Submit]. Therefore, you will be able to prepare multiple KeyTags for use with minimal interaction with the software and/or computer.
Chapter 4    Preparing KeyTag(s) for use

Getting the best from your KeyTag

Many users of humidity and/or temperature loggers are used to attaching the logger to a hook or tie-wrapping them to a monitored object. A wide variety of attachment methods can be used with the hole on upper right hand corner of the KeyTag, such as bolting the KeyTag in position, attaching it to a packaging strap, using a car-seal for security or other means.

The hole is quite strong, so most means of attachment will not compromise the structural integrity of the KeyTag. We do, however, recommend that the dead weight stress on the hole itself not exceed 5 pounds (2 Kg).

The sensor for the KeyTag is also very responsive, so we recommend you position the KeyTag in a location, where it will not be susceptible to changes in temperature due to operational activities. For example, it is not recommended you place a KeyTag beside a door way, as every time someone passes through the door, the KeyTag will register the change of environmental temperature due to the breeze that will be generated by the person, which does not necessarily reflect the overall temperature of the environment been monitored.
Prolonging battery life

If your KeyTag is not going to be used for extended periods of time, it may be worthwhile to set the KeyTag into "Hibernation" mode. In "Hibernation" mode the KeyTag will consume minimal power, which will extend the battery life when compared with leaving an idle KeyTag in operating mode.

While a KeyTag is in "Hibernation" mode it will:

1. Not be able to record and store any new readings.
2. Not activate the Alert and OK lights.
3. Not respond to the START MARK button being pressed.

To return a KeyTag from "Hibernation" mode to normal operating mode so that it can record and store new readings, go through the usual process of preparing it for next use.

To set a KeyTag to "Hibernation" mode, select the "Hibernate..." menu item in the “KeyTag...” menu.
The following example illustrates using the "Hibernation" feature.

1. Locate KeyTag(s) and set them to Hibernate mode.

<table>
<thead>
<tr>
<th>Location</th>
<th>Interface Model</th>
<th>KeyTag ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>KTJ/USB</td>
<td>5010003049</td>
</tr>
</tbody>
</table>

The software will locate the KeyTag products for you and set them to Hibernate mode.
In this screen you will see one of the following pictures next to each of the items in the list:

- (no picture) indicates the KeyTag is still in the process of being set to "Hibernation" mode.
- ✔ The KeyTag was successfully set to hibernation mode.
- ✗ The software was unable to set the KeyTag to hibernation mode.

Once a KeyTag has been successfully set to "Hibernation" mode it should be removed from the Interface Cradle before pressing any other button. As soon as the software communicates with a KeyTag in "Hibernation" mode, for example through automatic download, Hibernation, etc, it will be returned to normal operating mode.

The extent to which the Hibernation mode will prolong the battery life of a KeyTag may vary between different models and versions of KeyTag products. Some KeyTag models may not support Hibernation.
CHAPTER 5

Results from KeyTag

The KeyTag stores the recorded readings in its internal memory. Since the KeyTag contains the recorded readings in its internal memory, you must use the KeyTag Analyzer software to extract the information from the KeyTag through the Interface Cradle and into a format that can be displayed to you in a meaningful way. It is usually very important that the information retrieved from a KeyTag is retained. The software will automatically save the information retrieved from a KeyTag to your disk drive so that you can view the information at a later date, a useful feature if you require traceability. This chapter explains how you can retrieve the recorded information stored within a KeyTag and have the software display it to you on the screen in a meaningful way.

In This Chapter

Getting results from KeyTag .....................................42
Understanding the results .........................................43
Inspecting the information at close range .......................44
Manual scaling of the chart .......................................48
Chart annotations....................................................49
Chart subtitle ........................................................51
Combining charts onto a single chart ..............................53
Automatically calculated statistics ...............................62
Displaying statistics ................................................66
Printing the results ..................................................67
Sending a file by e-mail direct from Analyser .................68
Calling up previous results .......................................69
Digital signatures ....................................................71
How secure is my data .............................................72
Viewing file properties ............................................74
Getting results from KeyTag

You can retrieve the recordings from KeyTag(s) as many times as you require. The process of retrieving data stored within a KeyTag does not erase it from the KeyTag's memory. If the KeyTag is currently recording while you retrieve the information, it will continue to record without interruption.

There are three ways to retrieve the recorded results from a KeyTag.

1 While the KeyTag Analyzer software is open (does not need to be the currently active software), simply slot the KeyTag into the Interface Cradle. If the automatic download feature is enabled, the software will automatically retrieve the recorded readings, save the information to your disk drive and display the information to you. While the software is automatically retrieving the readings you will see an animated picture appear, similar to the following picture.

2 Click the "Download..." menu item located in the KeyTag menu.

   ![Image](image.png)

   A new KeyTag has been detected in the interface. Please wait while its readings are downloaded. There are 1 remaining KeyTag(s) to download.

   This is the second quickest option, as it does not include the steps involved in preparing the KeyTag(s) for their next use.

3 Click the KeyTag icon or the "Wizard..." menu item located in the KeyTag menu.

   ![Image](image.png)

   This option will allow you to prepare the KeyTag for its next use after retrieving the readings stored within the KeyTag. If you do not need to configure the KeyTag for its next use now, the previous option described may be preferred as it will not involve the configuration steps and therefore be a quicker and simpler method.
The wizard will appear once you have selected the appropriate option of your choice to guide you through the necessary steps to retrieve the recorded readings. While the wizard is visible the "Automatic download" feature will be temporarily disabled. You will not be able to access any of the Wizards while an "Automatic download" is in progress.

Understanding the results

The Data Screen is an all purpose data display. The window appears inside the main KeyTag Analyzer window, and has a series of tabs along the bottom. Each of these tabs changes the Data Screen display.

<table>
<thead>
<tr>
<th>Chart</th>
<th>A display of the data in a time versus humidity and/or temperature chart.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>A listing (spreadsheet style) of the time versus humidity and/or temperature data.</td>
</tr>
<tr>
<td>Summary</td>
<td>A summary of the data, including averages, ranges, alert results, KeyTag identification data, and other information.</td>
</tr>
<tr>
<td>Pre-Start Chart</td>
<td>A chart of data stored by the KeyTag prior to it being started.</td>
</tr>
<tr>
<td>Pre-Start Data</td>
<td>A listing of the data stored by the KeyTag prior it being started.</td>
</tr>
<tr>
<td>Pre-Start Summary</td>
<td>A summary of the data stored by the KeyTag prior to it being started.</td>
</tr>
<tr>
<td>All Chart</td>
<td>A chart of the all of the data stored in the KeyTag including the data prior to it being started and after being started.</td>
</tr>
<tr>
<td>All Data</td>
<td>A listing of the all of the data stored in the KeyTag including the data prior to it being started and after being started.</td>
</tr>
<tr>
<td>All Summary</td>
<td>A summary of the all of the data stored in the KeyTag including the data prior to it being started and after being started.</td>
</tr>
</tbody>
</table>
The screens that are typically used are the first three (Chart, Data and Summary), since they represent the normal usage of the KeyTag. The other Data Screens are included to deal with situations where the KeyTag may have not been activated due to user error; the data is still collected and available. KeyTags may be handled by those who are unfamiliar with the start feature. The "pre-start logging" feature protects against accidental “no starts” to preserve data that may be valuable.

In some cases, not all the "tabs" previously described will be displayed, for example you may only see Chart, Data and Summary. If the KeyTag has been configured to not record any pre-start data, the downloaded data will not display any; you will only see the data that has been set up in the "configured mode" and recorded after starting the KeyTag. Pre-start recording is an option, not a default. Also if the KeyTag was configured to record continuously and the data has wrapped in memory all the pre-start data would have been replaced with more recent data and as such there will be no pre-start data left to display.

Inspecting the information at close range

When a file is displayed either from downloading or from calling up a stored data file, the file typically appears as a chart. It might look something like this:
The display does not show all of the available data points. For more detail, you can zoom in and display just one small section of the charted data. Using the mouse, find the upper left corner of a window of interest, hold down the left mouse button, and move the mouse to the bottom right corner. The zone of interest will be highlighted.

The highlighted zone is immediately displayed after the left mouse button is released on the maximum displayable resolution:
This display now shows the maximum detail from the highlighted area.

When this mouse operation has been completed, for example, a picture of the highlighted area can be placed on the clipboard. This picture can be then be pasted into any Microsoft Windows® application. For example, if you are writing a letter and want to illustrate a point based on chart data from a KeyTag, you can paste the picture of the chart directly into the letter.

When the mouse pointer is moved over the chart, a small window (tooltip) is displayed near the mouse pointer. It displays the reading closest to the mouse pointer position. If the readings are very close together, it is a good idea to zoom in to an area of interest to inspect individual readings with the help of tooltips.

Whenever the data displayed on the chart has been zoomed in to show more detail and is showing only a portion of the charted data, if you click on the corresponding Data tab you will see that only the readings shown on the chart are currently displayed. If you also click on the corresponding Summary tab you will see an additional section of statistics that have been calculated based on only the portion of readings currently being shown on the Chart screen. Following is an example of the additional section of statistics that will appear within the Summary Screen when a section of the readings within the Chart screen have been zoomed in.

<table>
<thead>
<tr>
<th>Statistics of zoomed range of readings</th>
</tr>
</thead>
<tbody>
<tr>
<td>First reading</td>
</tr>
<tr>
<td>Last reading</td>
</tr>
<tr>
<td>Elapsed Time</td>
</tr>
<tr>
<td>Reading range</td>
</tr>
<tr>
<td>Average reading</td>
</tr>
<tr>
<td>Standard Deviation</td>
</tr>
<tr>
<td>Degree Minutes below lower alert</td>
</tr>
<tr>
<td>Degree Minutes above upper alert</td>
</tr>
<tr>
<td>Mean Kinetic Temperature</td>
</tr>
<tr>
<td>Time below lower alert</td>
</tr>
<tr>
<td>Time above upper alert</td>
</tr>
<tr>
<td>Time not in alert</td>
</tr>
</tbody>
</table>
If there are readings beyond the limits of the sensor within the time interval that is being displayed, the statistics for this interval will be displayed as "***".

The Zoom Out (🔍) command in the Edit menu or on the toolbar can be used to revert the display back to showing the range of data points that were showing prior to the new zoom section being selected.

Inspection marks are recorded each time the START MARK button is pressed on the KeyTag. Each inspection mark is numbered and can be identified by counting the number of marks on the Chart display. If you click on the corresponding Summary tab and scroll down in the data record you will see a summary of all the points that were recorded between each subsequent inspection mark. Following is a picture of a portion of a Summary Screen showing the relevant information for the sequence of data points between the inspection mark #2 and inspection mark #3.

<table>
<thead>
<tr>
<th>Statistics for between inspection mark #2 and inspection mark #3</th>
</tr>
</thead>
<tbody>
<tr>
<td>First reading</td>
</tr>
<tr>
<td>Last reading</td>
</tr>
<tr>
<td>Elapsed Time</td>
</tr>
<tr>
<td>Reading range</td>
</tr>
<tr>
<td>Average reading</td>
</tr>
<tr>
<td>Standard Deviation</td>
</tr>
<tr>
<td>Degree Minutes below lower alert</td>
</tr>
<tr>
<td>Degree Minutes above upper alert</td>
</tr>
<tr>
<td>Mean Kineic Temperature</td>
</tr>
<tr>
<td>Time below lower alert</td>
</tr>
<tr>
<td>Time above upper alert</td>
</tr>
<tr>
<td>Time not in alert</td>
</tr>
</tbody>
</table>
Manual scaling of the chart

To change the temperature and humidity scale, or select a range of readings by time and date, select “Manual Scaling” from the chart popup context menu.

The following dialog will be displayed:

![Manual Scaling dialog]

Range of sensor The chart is zoomed to the minimum and maximum values for each sensor.

Range of readings The chart is zoomed to the minimum and maximum reading values.

Manual Scaling This option lets you specify the date/time range, temperature and humidity ranges (if applicable) for the chart display. The dialog shows the current zoom settings.

Click [OK] to apply your selected settings.

To return to the previous zoom level, use the Zoom Out (command) in the Edit menu or on the toolbar.

By default, each chart is initially displayed zoomed to the range of readings. This default setting can be changed in the Options dialog (see chapter “Charts”).
Chart annotations

To include more information in your chart you can add chart annotations. These will be displayed and printed with your chart.

Click the right mouse button at the location where you want to add the annotation. Select “Add” from the Annotations popup context menu. Enter the annotation text and click **OK**. The annotation will be displayed in the chart. When you zoom the chart display, the annotation will be zoomed with the chart readings.
To edit an annotation, move the mouse pointer into the area of an existing annotation. Click the right mouse button and select "Edit" from the Annotations popup context menu. Edit the text and click OK to display the edited annotation.

To delete an annotation, move the mouse pointer into the area of an existing annotation. Click the right mouse button and select "Delete" from the Annotations popup context menu. The annotation will be deleted.

To delete all annotations, select "Delete All" from the Annotations popup context menu.

Selecting the "Show" command from the Annotations popup context menu will show or hide all of the annotations on the chart.

To save the annotations, click the toolbar button or select the "Save" command from the "File" menu. The annotations will be saved in a file with the same name as the data file and the file extension ".anno".

When saving annotations in Multi Chart mode, the software will ask you to specify a file name for the Multi Chart configuration, if you are saving this configuration for the first time.
Chart subtitle

The chart subtitle is displayed and printed underneath the chart title.

To edit the subtitle, right-click on the area above the chart and select "Edit Chart Subtitle" from the popup context menu.
Enter or modify the text, then click **OK** to display the edited subtitle. To remove the subtitle, delete the text in the Edit Chart Subtitle dialog and click **OK**.

To save the chart subtitle click on the **Save** toolbar icon or select the **Save** command from the **File** menu.

If the KeyTag Analyzer application is in Single Chart mode, the subtitle (and annotations) for the currently active chart will be saved in a file with the chart file name and the file extension .anno.

In Multi Chart mode, the subtitle is saved in the Multi Chart configuration file (file extension .multi). If you are saving the configuration for the first time, you will be asked to specify a file name for the Multi Chart configuration.
Combining charts onto a single chart

To overlay multiple charts in one view, select the Multi Chart command. All charts that are currently open will be displayed together. Additional files opened while in Multi Chart mode (including data downloaded from KeyTags) will be added to the display.
Each of the individual charts will be displayed with a letter symbol to allow you to tell them apart. The legend contains an entry for each chart showing the chart name and the corresponding letter.

You can change the background color for the Multi Chart display through the **Charts** section in the **Options** Window.

To remove charts from the Multi Chart display, use the Single Chart (]\) command to switch to Single Chart mode, then close the files you don't want to display. Select the Multi Chart ([]) command to switch back to Multi Chart mode.

You will notice that the Data and Summary tabs are not available in the Multi Chart display. If you require additional information about the chart data, activate the display of the desired statistics on in the **Chart Statistics** section in the **Options** Window. The chosen values will be displayed separately for each chart.

You can also view **Min, Max and Average Charts** (see "Special Chart Tabs" on page 57), and select other options.

### Shifting chart start times

For easier data comparison, chart start times can be shifted in Multi Chart display. There are two ways to shift a chart along the time axis:

1. Move the mouse pointer over the chart until the appropriate tooltip is displayed. Right-click, then select the "Shift Chart" command from the popup context menu. This will cause the following dialog to be displayed, where the new start time and date can be entered, or the chart can be revert to its original date/time by selecting the "Original start time" button. Click the OK button to display the change.
2. Press and hold the CTRL key, left-click on the chart you would like to move, and drag the chart to new the position.

An additional time axis is displayed for each shifted chart indicating the corresponding time in relation to the original start time.

Note: Shifting a chart will not change any of the original recorded data, only the location the data is displayed in relation to other charts within the Multi Chart display will change.
Changing Chart Colours

By default, all charts in the Multi Chart display are displayed in the colors specified in the **Charts** section within the **Options** Window.

To change the display color of individual charts/sensors, move the mouse pointer over a chart until the tooltip is displayed. Right-click, then select "Change Chart Color" from the popup context menu.

Select the desired colors for the chart readings and markers in the color selector boxes. To restore the default color (as specified in the **Charts** section within the **Options** Window), select the "Restore Defaults" command.
Aligning Charts

Select "Align Charts" from the popup context menu to automatically align all charts in the current Multi Chart window.

The charts are aligned to the earliest start time:

- "Chart" tab: All start times are aligned.
- "Pre-start Chart" tab: All charts with Pre-start readings are aligned to the earliest Pre-start reading.
- "All Chart" tab: Charts are aligned to the earliest reading (Pre-start reading if any Pre-start readings have been recorded for the chart).

Every chart is assigned a different colour and a time axis is displayed to illustrate the original start time. You can display the elapsed time instead of the date/time by selecting the "Elapsed Time" option in the Chart Options dialog (Charts).

Aligning charts in one tab will also influence how these charts are represented in the other tabs. If for example you select "Align Charts" in the "Chart" tab, and switch to the "All Chart" tab, you will notice that the charts are now aligned at a new origin, with all pre-start readings to the left and all readings to the right of this origin. The charts in the "Pre-start" tab are aligned with the last pre-start reading to the right.

To revert to the original start times for all charts, select in the toolbar to switch to Single Chart mode, then switch back to Multi Chart mode with .

Special Chart Tabs

When you select the average tab command in the toolbar, up to three additional chart tabs will be shown, with the Chart Average tab highlighted:
These chart tabs display graphs calculated from the "Chart", "Pre-Start Chart", and "All chart" tabs and show minimum, maximum and average value graphs. Changes in either of the three original data displays, such as adding a new file and aligning or shifting charts, result in a re-display of the corresponding "Min/Max/Average" tab, e.g. if one of the charts in the "Pre-Start Chart" is shifted, the "Pre-Start Min/Max/Average" chart would redraw showing graphs based on the updated values.

You can annotate these special chart tabs in the same way as other chart tabs; such annotations will be visible in the other chart tabs and are stored with the multi chart when saved.

Please note that following behaviour applies to these special chart tabs:

- Zoom settings will not be transferred to the "Average" tabs.
- Download marks and inspection marks will not be displayed in the "Average" tabs.
- Non-validated readings and re-calibrated readings will not be displayed with the special attributes, even if set in the options. If you have chosen to "show non-validated readings", they are included in the minimum/maximum/average calculations, otherwise not.
- To avoid memory overflows there are some restrictions regarding the maximum allowed time span of the charts in a multi-chart. These restrictions vary with logging interval, should you try to add a chart outside the allowed range following dialogue box will appear:

![Error Message]

In this case the multi chart will disassemble, so you can close the window whose chart you no longer want to display, and re-assemble the multi-chart by clicking on [Re-assemble].
- If one or more of the charts have sections with readings outside the KeyTag's sensor range, KeyTag Analyzer is unable to calculate the minimum, maximum and average values, and those sections of the graph will not be displayed. This will likely result in a "broken" graph line, regardless of whether "show readings beyond specifications" in the **Charts** section in the **Options** Window is enabled or not.

- Due to the large number of calculations performed in this feature, specifically when opening large numbers of charts spanning long periods, having the average tabs displayed can occupy large amounts of memory and run slow. Therefore we recommend only turning the feature on when required.

Clicking on the highlighted average tab 图标 command will turn the average tabs off. Selecting the single charts 图标 command in the toolbar while the average charts are active will disassemble the multi chart, and when switching back to multi chart the average tabs will be displayed again until turned off.

**Behind The Scenes**

To create some meaningful results, KeyTag Analyzer uses a special trend line process to calculate the minimum, maximum and average values across multiple charts, rather than a histogram. It is important you understand this mechanism, so you can interpret the displayed readings correctly.

This is an example of two KeyTags, one with a 5 minute log interval (A) and the other (B) logging every 2 minutes.
Before the data are displayed in an average tab, KeyTag Analyzer normalizes every chart’s readings so they fall in line with the logging interval of the KeyTag with the shortest log interval, in this case unit (B). It does not shift any charts, but rather calculates a theoretical value for those reading times by linear interpolation. Interpolation determines probable environmental conditions, i.e. what the KeyTag would have recorded if taking a reading at that time.

Without this method, it would not be possible to compare KeyTags with different log intervals, or units that have the same log interval, but were started at different times.

Starting with the earliest time present in the chart, a value is created for each KeyTag as if it had recorded a log at that time. It is those values that are used to calculate and display the minimum, maximum and average charts.
As a result of this process, absolute values for minimum and maximum may not always be shown if they do not fall on normalized times, as seen in the example at 10:35 - despite 21ºC being the maximum it will not be displayed as it is not a normalized value.

Note: The charts in above example are based on KeyTags started at the same time. If unit (A) had been started earlier, depending on the start time unit (B) may also have its readings interpolated.

To ensure the chart with the shortest log interval always has its real values shown, please use the Aligning Charts (on page 57) function from the context menu.

---

**Saving a Multi Chart file**

Click on the toolbar icon or select the "Save" command from the File menu to save the current Multi Chart configuration. Select a file name and location for your Multi Chart file. The file extension for Multi Chart files is ".multi".

Note: The Multi Chart file should be saved in the same folder as the individual data files. If any of the data files referenced in a Multi Chart file are renamed, deleted, or moved to a different folder, the Multi Chart configuration cannot be displayed.

The configuration file contains information about the data files included in the Multi Chart display, the subtitle, chart colors, and time offset (see Shifting chart start times).

Any annotations added to the Multi chart display are saved in a separate annotation file with the file extension ".anno". This file must be located in the same folder as the Multi Chart file to be included in the Multi Chart display.

To open a previously saved Multi Chart configuration file, click on the toolbar icon or select the "Open..." command from the File menu, then select the ".multi" file to be opened.

To save a Multi Chart file under a different name, select the Save As... command from the File menu and enter a new file name.
Automatically calculated statistics

When a file is displayed either from downloading or from calling up a stored data file, the software will automatically calculate and display some statistics of the recorded data. These statistics are shown on the corresponding Summary tab and are also calculated for each sequence of data points between the inspection marks.

If any readings within the time interval are beyond the limits of the sensor, the values for Average Reading, Standard Deviation, and Mean Kinetic Temperature will not displayed for the relevant time interval.

In This Section

Average Reading .................................................... 62
Standard Deviation ................................................. 63
Mean Kinetic Temperature ...................................... 64
Degree Minutes..................................................... 65

Average Reading

The Average Reading is the arithmetic mean of the sequence of data points. It is calculated by adding all the data point values together and then dividing the total by the number of data points. Mathematically this formula can expressed as illustrated in the following picture:

\[
\text{AV} = \frac{1}{n} \sum_{i=1}^{n} t_i
\]

Where:

\( av \)  the calculated arithmetic mean
\( n \)  the number of data points to include in the calculation
\( t_i \)  a data point to include in the calculation

For example, if there were 5 data points to calculate the arithmetic mean of and they were, 12.3, 15.9, 16.2, 14.7, 14.9, then the arithmetic mean would be 14.8.
Chapter 5    Results from KeyTag 63

Standard Deviation

The standard deviation is a useful for determining how spread out the readings are from the arithmetic mean (Average Reading). Most controlled environments typically try to keep the environmental conditions at a stable and consistent humidity and/or temperature. The standard deviation can be used to help indicate how stable the environmental conditions were maintained. One standard deviation (sometimes expressed as "one sigma") away from the mean, positive or negative represents approximately 68 percent of all the readings. Two standard deviations, or two sigmas, away from the mean represents approximately 95 percent of the readings. Three standard deviations represent about 99 percent of the readings.

For example, if the arithmetic mean of the readings was 50.6°C and the standard deviation was 2.3°C, then approximately 68% of the readings were between 48.3°C and 52.9°C, 95% of all the readings were between 46.0°C and 55.2°C and 99% of the readings were between 43.7°C and 57.5°C. Further more, if all the readings were recorded over a span of 1 day (24 hours) then the temperature was between 48.3°C and 52.9°C for approximately 16 hours and 19 minutes during the recorded period of time.

Mathematically the formula for calculating the standard deviation can expressed as illustrated in the following picture:

\[
\begin{align*}
S &= \sqrt{\frac{\sum_{i=1}^{n} (t_i - \text{av})^2}{n - 1}}
\end{align*}
\]

Where:

- \(s\) the calculated standard deviation
- \(n\) the number of readings to include in the calculation
- \(\text{av}\) the calculated arithmetic mean
- \(t_i\) a reading to include in the calculation

For example, if there were 5 readings to calculate the standard deviation of and they were, 12.3, 15.9, 16.2, 14.7, 14.9, then the standard deviation would be 1.54
Mean Kinetic Temperature

There are some products and materials that exist which have accelerated rates of degradation at higher temperatures. For example, perishable food items, pharmaceutical products and many forms of bacteria can grow/degade exponentially as the environmental temperature increases. Mean kinetic temperature is a calculation that accommodates the non-linear thermal effect temperature can have on products. Mean kinetic temperature is represented as the equivalent temperature the product was thermally subjected to during the period of time the various temperature reading were recorded.

Mathematically the formula for calculating the mean kinetic temperature can expressed as illustrated in the following picture:

\[
mkt = \frac{-\Delta H}{R} \left( \sum_{i=1}^{n} \exp \left( \frac{-\Delta H}{R \times (t_i + 273.15)} \right) \right) - 273.15
\]

Where:

- \( mkt \) Mean kinetic temperature, in degrees Celsius
- \( \Delta H \) the activation energy. KeyTag Analyzer uses an activation energy value of 83.144 KJ/mol for the calculation.
- \( R \) the universal gas constant, which is 0.0083144 KJ/mol K
- \( n \) the number of data points to include in the calculation
- \( t_i \) a data point to include in the calculation, in degrees Celsius

For example, if there were 5 data points to calculate the mean kinetic temperature of and they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius, then the mean kinetic temperature would be 14.9 degrees Celsius.
Degree Minutes

There are some products and materials that exist which can change their characteristics and/or degrade if they experience temperatures which are not within ideal conditions for long enough. For example, some products may experience freezer burn if they experience an extremely cold condition or experience a colder than ideal temperature for long enough period of time. Other products for example, ice cream, change their characteristics if they experience temperatures which allow it to melt. The KeyTag Analyzer will automatically display the results of two separate Degree Minutes calculations. The result of the first Degree Minutes calculation displayed will be based on the readings that were recorded below the ideal conditions and the result of the second Degree Minutes calculation displayed will be based on the readings that were recorded above the ideal conditions. The ideal conditions used in the calculation of the Degree Minutes formula are based on the upper and lower alert values that where configured when the KeyTag was originally prepared for use.

Mathematically the formula for calculating the degree minutes above alert can be expressed as illustrated in the following picture:

\[ \text{deg min} = \sum_{i=1}^{n} \text{abs}(t_i - a) \times s \]

Where:

\[
\begin{align*}
\text{deg min} & \quad \text{Total Degree Minutes spent above/below the alert threshold.} \\
\text{t} & \quad \text{The temperature that was above/below the alert threshold.} \\
\text{a} & \quad \text{The alert temperature threshold.} \\
\text{s} & \quad \text{The duration of time, in minutes, the temperature was sustained.}
\end{align*}
\]

For example, if there were 5 data points to calculate the degree minutes of and they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were recorded at 2 minute intervals and the high alert temperature threshold was 12.6 degrees, then the degree minutes temperature above the upper alert threshold would be 22.6 degree-minutes.
Displaying statistics

The statistics displayed on the Summary tab can be configured in the Options dialog. Refer to the (see chapter "Summary Statistics"). By default, all statistics are displayed on the Summary tab.

Statistics can also be displayed on the chart, underneath the legend. See chapter "Chart Statistics" for more information about configuring the chart statistics.

If there are readings beyond the limits of the sensor within the time interval being displayed, the statistics for the relevant interval will be displayed as "***".
Printing the results

Printing from KeyTag Analyzer is slightly different to printing from other common Windows software, as the printer functions in terms of range of information to print rather than range of pages. This technique allows you to focus on what you want printed rather than the pages showing the information.

You can choose to print all of the information, select a range of dates and times to print from or select a range of "inspection" marks. This could be a very important for transit monitoring since post trip and pre-event data are not significant to a discussion or dispute centering on a humidity and/or temperature maintenance issue.

![Print Window](image)

The print window can be brought up by simply clicking once on the "Print" icon located on the toolbar or by clicking the "Print..." menu item from within the File menu.
Sending a file by e-mail direct from Analyser

You can send files of interest to another person, by e-mail, directly from the software without the need to exit to your e-mail software or to deal with file attachments.

While you have the file of interest open and being displayed on the screen, just click once on the "Send Mail" icon (addr) located on the toolbar and your e-mail software will pop up with the file already inserted as an attachment. Type the desired e-mail address to send the file of interest to, add any message that you wish to include, and then click "Send". That is all.

Clicking the "Send..." menu item within the File menu will achieve the same results as clicking the "Send Mail" icon as previously described.

Note, the recipient of the file will also need to have a copy of the KeyTag Analyzer software to open and view the file that you sent. KeyTag Analyzer software is free and can be downloaded from the KeyLog Recorders Internet site, www.keylog.nl.

If you want to attach your data files in file formats other than the KeyTag Analyzer format, specify the desired file formats in Exports and Reports section in the Options Window. The data files will automatically be attached to your e-mail(s) in the desired formats.

To send a Multi Chart configuration, the configuration must first be saved to disk (see chapter Saving a Multi Chart configuration). The "Send Mail" command will automatically attach the multi chart configuration file, the annotation file (if annotations have been added) and the relevant individual data files to your e-mail(s).
Calling up previous results

The files that have most recently opened and displayed are listed towards the bottom of the "File" menu. To open other files, click the "Open" icon located on the toolbar, which will display the "Open" file dialog similar to the following picture and allows the user to locate and open one or more files of interest.
Clicking the "Open..." menu item within the File menu will achieve the same results as clicking the "Open" icon as previously described.

After the software has been installed for the first time, there are two recently opened files listed in the "File" menu, even though no files have been opened yet. These are sample files, which were installed along with the software so that users can see an example of information that can be retrieved from KeyTags. These files are not required for the correct operation of the software and therefore may be deleted at any time.

If the software is unable to open the file, it will display an error similar to the following picture. Clicking on Check Now will bring up the process of checking the Internet for an updated copy of the software.
Digital signatures

Support for digital signatures is primarily provided for compliance with the US FDA 21 CFR Part 11 regulation - Electronic records and electronic signatures. Various industries however, may find inclusion of digital signatures beneficial towards their quality control and assurance systems.

Digital signatures allow users to include their digital signature within a KeyTag Analyzer file along with a meaning/reason for the inclusion of the digital signature. To add digital signatures to KeyTag Analyzer files, the copy of the KeyTag Analyzer software being used must be connected to the KeyTag User Server software. For more information about how to get the software to connect to the KeyTag User Server software see the "User Server" set of options settings and/or contact your local network administrator.

While the file that the digital signature is to be added to is open and currently selected, add a digital signature by clicking on the "Digital Signatures" icon located on the toolbar, which will display the "File Properties" dialog with the "Digital Signatures" tab already activated, similar to the following picture.
Then click **Now...** to begin the process of adding a digital signature to the file. If **Now...** is disabled, moving the mouse pointer over **Now...** and leaving it still for a short time will reveal the reason why the button is disabled.

Once the "Add Digital Signature" dialog is visible, enter your KeyTag Analyzer user password and select the meaning for the digital signature that is being added.

![Add Digital Signature Dialog](image)

Click **OK** to permanently add the digital signature to the file or **Cancel** to not add the digital signature. Multiple digital signatures from the same and/or different users to KeyTag Analyzer files may be added to a single file.

**How secure is my data**

All KeyTag files are encrypted and contain checks to detect if the file has been tampered with since it was originally created. If the software detects that a file has been tampered with, even by only one character or has become corrupted and therefore the data within does not represent the data originally retrieved from the KeyTag, the software will not open the file and display the information within.

An additional validation and security feature of the KeyTag is that it will automatically insert error detection codes periodically during recordings, which are used to detect corruption or manipulation of data. Whenever these detection codes for a block of recordings fail its integrity validation test, the relevant readings become marked as non validated readings. Non validated readings are displayed differently to validated readings to indicate that they have failed their integrity test.

Non validated recordings typically occur in the scenarios following scenarios:

1. One or more readings within the non validated block of readings is not the genuine recorded value.
The KeyTag has been configured to perform continuous recordings and once the memory within the KeyTag has been fully used, will cause older recordings to be overwritten, which will thereby invalidate the error detection code and integrity check for the block of readings the older recordings been overwritten exist within. In this scenario, it is not a problem that these recordings are non validated, rather it means that the particular block of recordings has only the validation and integrity protection offered by the communications between the KeyTag and the computer system, which is typically the same, if not better than the level of protection offered by every other brand of logger available in the global market, that KeyLog Recorders know of.

A communications or hardware failure has occurred during the transfer of the data from the KeyTag to the computer. In this scenario the problem is typically resolved by trying to retrieve the recordings from the KeyTag again, while ensuring the contacts on the back of the KeyTag are clean, that the contacts within the Interface Cradle are clean and that the contacts within the Interface Cradle are returning evenly to their normal position when the KeyTag is removed.

Since the software does not modify any of the recorded data within a KeyTag file at any time, if the software can open the file, regardless of how long ago it was created, the contents of the file will still represent the original recorded information retrieved from the KeyTag.

Therefore, the files created by the KeyTag Analyzer software meet all criteria for data integrity and data security as set forth in the US FDA 21 CFR Part 11 regulations. The firmware code that is embedded in the processor chip of each KeyTag cannot be extracted or reverse-assembled. Accordingly, data sets that are recorded on the memory within the KeyTag cannot be downloaded or modified except by being transferred to a KeyTag file. There is no way to interfere with the process of the transfer of information between the KeyTag and the software in such a way that data integrity would be compromised.
Viewing file properties

The file properties, which is accessed through the **File Menu** and/or through the toolbar command, provides users with a brief summary about the data included within the file, as indicated in the following picture.
This file properties information is also available for viewing directly through the Windows Explorer software that was included with the Windows operating system, without the need to have the KeyTag Analyzer software open. To view the information, simply locate the file of interest with Windows Explorer and, using the mouse, click the right button over the file and select the "Properties" menu item, with the left mouse button from the menu that will be displayed, similar to the following picture.

Select the "Summary" tab and you will see the summary of the data contained in the file. If the contents of the file require a newer version of software to open and view, have become corrupted or have been modified then the "Summary" tab will not be visible.

If the KeyTag has a limited number of trips left, this is also indicated here.
In the "Edit" menu is a command called "Options...".

This menu command opens a Window, which will allow the many of the features that the software offers to be customized. The following sections will provide an explanation of each of these options so that users will be able to make the best use of the software. The options that are available for customization are grouped together into the following sections:

- **General Settings**
- **Summary Statistics**
- **Chart Statistics**
- **Charts**
- **Automation**
- **File and Folder Settings**
- **Exports and Reports**
- **Date and Time**
- **Communication Ports**
- **User Server**

All of the options available will change the software in real time. For example, if the language selection and/or the date format are changed, all windows that are open will be updated without the need to restart the software.
All these options, excluding the User Server settings, are stored on a per user basis. Therefore, if more than one user operates on a single workstation the software will allow different customization settings for each.

In This Chapter

General Settings ..................................................... 77
Summary Statistics ................................................... 78
Chart Statistics ....................................................... 79
Charts ................................................................. 80
Automation ........................................................... 82
File and Folder Settings .......................................... 84
Exports and Reports ................................................. 88
Dates and Times .................................................... 90
Communication Ports ............................................. 93
User Server ........................................................... 94
Software Updates ................................................... 95

General Settings

The General Settings options allow you to change various preferences that will effect the overall appearance of the information shown by the software.
Show temperatures in

This will determine what units of measurement temperatures will be displayed in. The options include:

- Fahrenheit (°F)
- Celsius (°C)
- Kelvin (K)

Use Font

Determines what font to use to display and print information about KeyTag recordings and is changed through the Font... button. A sample of the font selected will be shown to you on the screen.

Language

This instructs the software which language for the software to use for all the information it displays and prints.

Summary Statistics

This option allows you to specify which statistics are displayed in the Summary tab. The statistics can be enabled or disabled by clicking the tick box for the relevant item in the list.
Chart Statistics

This option allows you to specify which statistics are displayed on the charts. The statistics can be enabled or disabled by clicking the tick box for the relevant item in the list.
The Charts options allow the various aspects of the charts that display the readings recorded by KeyTags to be customized. At the base of the Window is a color selector and other relevant controls, which apply to the highlighted item on the list in the window.
Some experimentation with these settings will show very quickly how they work. Select a color in the color panel, click [OK], and then go to the Data screen to see the results of the change.

Note that the three regions on the chart display can be controlled. KeyTags can be configured to detect over and under conditions based on a series of temperature and/or humidity measurements. When the data is displayed graphically on the chart, these become color background regions. These are different colors for "above high alert limit", "between high alert limit and low alert limit" and "below low alert limit". This allows out-of-range and in-range data to be spotted easily on the listed or charted data.

By selecting a line style for the "above high alert limit" and "below low alert limit" regions you can improve the readability of the charts on black and white printouts.

You can choose to include or exclude non-validated data from the chart display by checking or un-checking the "Non-validated readings" check box in the list. If non-validated data is to be displayed, it can either appear just like validated data, or you can define a different colour and marker style to be used. Check the check box "Display non-validated readings differently:" to display non-validated data in the selected colour/style.

Please refer to section *How secure is my data* (on page 72) for a detailed explanation of non-validated data.

When readings beyond the specified measurement range of a KeyTag have been recorded, the display will indicate this using the following techniques:

- The Chart display will not plot the out of range values and the chart curve will appear with broken lines.
- The Data display will include "<" or ">" for each reading that is beyond the specification range.
- The Statistics display will include "***" for each statistic that includes readings that are beyond the specification range.

If the option "Show readings beyond specification" is enabled, all reading values will be displayed, even if the recorded readings are beyond the operating range of the KeyTag.

For example, the KTL-8 has a published minimum temperature of -40°C. Temperatures to -41.5°C may be displayed if the “Show readings beyond specification” is enabled, however the accuracy of recordings between -40 and -41.5 is unknown. Temperatures between -40 and -41.5 will be displayed even if the temperature falls to a much lower actual value.

KeyLog Recorders provides no guarantee of temperature reading reliability or accuracy beyond the published range for a given product and the "Show readings beyond specification" option is not recommended to be enabled for general use.
The "Elapsed Time" option switches the x-Axis display between date/time and elapsed time since the beginning of the display period.

"Show Min/Max/Average Tab" shows up to three additional tabs in a multi chart with graphs representing Minimum, Maximum and Average readings (See *Combining Charts into a single chart*).

Most of the Chart Options settings can be enabled or disabled by clicking the tick box for the relevant item in the list.

**Automation**

The Automation options determine what the software does automatically when it detects a KeyTag in the Interface Cradle.
Enable automatic download of readings from KeyTags

Instructs the software to automatically retrieve recordings from a KeyTag when it is placed in an Interface Cradle that is connected to the computer. While the software is automatically retrieving recordings from a KeyTag an animated picture will appear on the screen to let the user know this action is being performed. With this function enabled, it is not necessary to go through the download wizard procedure. This function is very useful when working with multiple KeyTags.

This function can be temporarily disabled by holding down the “Ctrl” key on the keyboard while a KeyTag is placed in the Interface Cradle.

Display readings after successful download

Instructs the software to display the recordings after downloading them from the KeyTag. The default display format is determined by the "Display" setting in the “File Settings” option. This option will affect readings downloaded through the automatic download feature and when downloading through the Wizard approach.

Only show the latest set of readings after download

Instructs the software to only display the most recently retrieved set of readings on the screen. If there are multiple windows of readings open and being displayed, all of these windows will therefore be automatically closed and only the most recently retrieved set of readings will be displayed.
File and Folder Settings

The File and Folder Settings options help you manage the KeyTag data files.

Display X items in my most recently used list

This determines how many of the most recently accessed files are listed in the "File" menu for quick access to be opened and viewed again. Once this number of files has been reached, the reference to the oldest file opened will be removed and the most recently opened file will be added to position 1. Only the file reference is removed from this list, the actual file is not deleted. Changing this setting will take effect the next time KeyTag Analyzer is started.

Display

This determines how the information retrieved from a file and/or KeyTag will be first displayed. All other ways of displaying information will still be available regardless of which is selected here. The options include:

1. Chart, which will display the data in a time versus humidity and/or temperature chart.
2. Data, which will display a listing (spreadsheet style) of the time versus humidity and/or temperature data.
3. Summary, which will display a summary of the data, including averages, ranges, alert results, KeyTag identification data, and other information.
**File Name**

Whenever information is retrieved from a KeyTag it is always automatically saved to disk. This entry determines the method to be used to create a meaningful name of the file that will contain the data downloaded from the KeyTag.

The button at the end of the edit control (▼) can be used to assist you with defining how file names are to be created by inserting the appropriate predefined element that matches the information you want to use. Clicking on this button will display a popup list, similar to the following picture to allow you select from the available elements.

![Popup list](image)

To customize how the file name is created, you may use one or more of the available elements in any order. If you use spaces to separate the elements, these spaces will appear in the same location in the name of the file created. The letters must be in uppercase or lowercase as shown in the following table (for example, "%ID" not "%id") and all elements must be preceded by % if specified. Other characters that are included will appear in the same location and unchanged in the file name creation.

<table>
<thead>
<tr>
<th>Element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>%DATE</td>
<td>The date when the KeyTag information was originally retrieved.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>%DATE-TIME</td>
<td>The date and time when the KeyTag information was originally retrieved.</td>
</tr>
<tr>
<td>%FINISH</td>
<td>The date and time of the last reading recorded after being started. If the KeyTag was not started then this information will be blank.</td>
</tr>
<tr>
<td>%FINISH-DATE</td>
<td>The date of the last reading recorded after being started. If the KeyTag was not started then this information will be blank.</td>
</tr>
<tr>
<td>%FINISH-TIME</td>
<td>The time of the last reading recorded after being started. If the KeyTag was not started then this information will be blank.</td>
</tr>
<tr>
<td>%FIRST</td>
<td>The date and time of when the KeyTag began recording information, even if it was under pre-start conditions.</td>
</tr>
<tr>
<td>%FIRST-DATE</td>
<td>The date of when the KeyTag began recording information, even if it was under pre-start conditions.</td>
</tr>
<tr>
<td>%FIRST-TIME</td>
<td>The time of when the KeyTag began recording information, even if it was under pre-start conditions.</td>
</tr>
<tr>
<td>%ID</td>
<td>The unique KeyTag identification value.</td>
</tr>
<tr>
<td>%LAST</td>
<td>The date and time of the last reading recorded, even if there are only pre-start recordings.</td>
</tr>
<tr>
<td>%LAST-DATE</td>
<td>The date of the last reading recorded, even if there are only pre-start recordings.</td>
</tr>
<tr>
<td>%LAST-TIME</td>
<td>The time of the last reading recorded, even if there are only pre-start recordings.</td>
</tr>
<tr>
<td>%PRODUCTID</td>
<td>The product identifier (part number) for the KeyTag used to record the data.</td>
</tr>
<tr>
<td>%SERIALNUM</td>
<td>The unique serial number of the KeyTag.</td>
</tr>
<tr>
<td>%START</td>
<td>The date and time the KeyTag was started to record information. If the KeyTag was not actually started and only pre-start information was recorded then this information will be blank.</td>
</tr>
<tr>
<td>%START-COUNT</td>
<td>The number of times the KeyTag has been started since manufacture.</td>
</tr>
<tr>
<td>%START-DATE</td>
<td>The date the KeyTag was started to record information. If the KeyTag was not actually started and only pre-start information was recorded then this information will be blank.</td>
</tr>
<tr>
<td>%START-TIME</td>
<td>The time the KeyTag was started to record information. If the KeyTag was not actually started and only pre-start information was recorded then this information will be blank.</td>
</tr>
<tr>
<td>%TIME</td>
<td>The time when the KeyTag information was originally retrieved.</td>
</tr>
<tr>
<td>%USERID</td>
<td>The user defined identifier for the set of information recorded by the KeyTag.</td>
</tr>
</tbody>
</table>
You may use the \ character to specify that a file name definition includes a sub folder name as well as the actual file name, which is useful if you want to group/sort files automatically together, for example, by date or by User Id.

Each of the following elements within the quotes (""") are not permitted, as they are not supported the operating system ": * ? < > |". If you do include one of these elements in the definition of how the file names are to be created they will be replaced with the _ character.

If you use a date and/or a time element, the format of that element will be determined by the settings defined in the "Date and Time" set of options.

Folder

This determines the location where the files are automatically stored. The location defined here can specify a local drive path or a network drive path. UNC folder names are supported. The (…) button at the end of the edit control will assist you to locate the default store folder by browsing the folder structure available to you, if you choose to use it.

Since this is the default location where files are stored, this also represents the default folder that will be used when searching for files to open (through the Open command in the File menu).

Uniqueness

This determines how the software will manage information retrieved from a KeyTag when a file of the same name already exists. For example, when you retrieve the information from the same KeyTag once every day, while the KeyTag is still recording and the KeyTag has not been prepared for its next use and started again. The options available include:

1 Always create a unique copy of files (recommended)
   If a file of the same name already exists, then the software will automatically append "Copy n" to the end of the file name, where "n" will be a unique number.

2 Overwrite file if the file already exists
   If a file of the same name already exists, the existing file is overwritten (deleted and replaced) with a file that contains the information just retrieved from a KeyTag.

3 Prompt if an existing file already exists.
   If a file of the same name already exists, then you will see a message appear asking you whether or not you want to overwrite and replace the existing file with the information just retrieved from the KeyTag.
   If you answer "Yes" then the action described in the option "Overwrite file if the file already exists", previously explained, will be performed.
   If you answer "No" then the action described in the option "Always create a unique copy of files (recommended)", previously explained, will be performed.
Exports and Reports

Every time recorded data is retrieved from a KeyTag it is automatically saved to disk in the software's native format so that it can be opened and viewed at a later date. However, it may be that the recorded data is to be regularly integrated with other data and/or view the recorded data using software other than KeyTag Analyzer. Exports and Reports will instruct the software to automatically create one or more files in a format that is compatible with the other software being used, whenever recorded data is retrieved from a KeyTag.
To instruct the software to create a copy of the file in a format other than the native format used by KeyTag Analyzer, simply tick the file format from the list available. To override and customize the contents of the particular file format, simply ensure the file format is highlighted and click **Customize...**. Once **Customize...** has been clicked, a window will be displayed that will show the available options that can be overridden.

All the additional files created will be automatically saved at the appropriate time using the filename and folder location defined in the "**File and folder settings**" options. Since these file formats are not the native KeyTag Analyzer file format, the KeyTag Analyzer software will no longer be able to detect whether or not the data within it is genuine and original and will not be able to display the information within the file.

To select file formats for the e-mail attachment created through the Send Mail command (see **Sending a file by e-mail direct from Analyzer**), tick the desired file formats in the second list.

Note: The list of Send Mail file formats contains only file formats selected in the Export formats list, plus the KeyTag Analyzer format.
The Date and Time options allow how the date and time information is displayed by the software to be overridden. It does not affect how the date and time information is stored and therefore, how the date and/or time information is shown can be changed at any time. At the bottom of this option window, a sample of the date and time using the formats selected will be displayed.

To customize how the date information is displayed, the following elements may be used. If spaces are used to separate the elements, these spaces will appear in the same location in the date displayed. The letters must be in uppercase or lowercase as shown in the following table (for example, "MM" not "mm"). Characters that are enclosed in single quotation marks will appear in the same location and unchanged in the date displayed.

<table>
<thead>
<tr>
<th>Element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>Day of month as digits with no leading zero for single-digit days.</td>
</tr>
<tr>
<td>dd</td>
<td>Day of month as digits with leading zero for single-digit days.</td>
</tr>
<tr>
<td>ddd</td>
<td>Day of week as a three-letter abbreviation.</td>
</tr>
<tr>
<td>dddd</td>
<td>Day of week as its full name.</td>
</tr>
<tr>
<td>M</td>
<td>Month as digits with no leading zero for single-digit months.</td>
</tr>
<tr>
<td>MM</td>
<td>Month as digits with leading zero for single-digit months.</td>
</tr>
<tr>
<td>MMM</td>
<td>Month as a three-letter abbreviation.</td>
</tr>
<tr>
<td>MMMMM</td>
<td>Month as its full name.</td>
</tr>
<tr>
<td>y</td>
<td>Year as last two digits, but with no leading zero for years less than 10.</td>
</tr>
</tbody>
</table>
yy  Year as last two digits, but with leading zero for years less than 10.

yyyy  Year represented by full four digits.

To customize how the time information is displayed, the following elements may be used. If spaces are used to separate the elements, these spaces will appear in the same location in the time displayed. The letters must be in uppercase or lowercase as shown in the following table (for example, "ss", not "SS"). Characters that are enclosed in single quotation marks will appear in the same location and unchanged in the time displayed.

<table>
<thead>
<tr>
<th>Element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>h</td>
<td>Hours with no leading zero for single-digit hours; 12-hour clock.</td>
</tr>
<tr>
<td>hh</td>
<td>Hours with leading zero for single-digit hours; 12-hour clock.</td>
</tr>
<tr>
<td>H</td>
<td>Hours with no leading zero for single-digit hours; 24-hour clock.</td>
</tr>
<tr>
<td>HH</td>
<td>Hours with leading zero for single-digit hours; 24-hour clock.</td>
</tr>
<tr>
<td>m</td>
<td>Minutes with no leading zero for single-digit minutes.</td>
</tr>
<tr>
<td>mm</td>
<td>Minutes with leading zero for single-digit minutes.</td>
</tr>
<tr>
<td>s</td>
<td>Seconds with no leading zero for single-digit seconds.</td>
</tr>
<tr>
<td>ss</td>
<td>Seconds with leading zero for single-digit seconds.</td>
</tr>
<tr>
<td>t</td>
<td>One character time-marker string, such as A or P.</td>
</tr>
<tr>
<td>tt</td>
<td>Multi character time-marker string, such as AM or PM.</td>
</tr>
</tbody>
</table>
For example, if the date was 2 January 2004 and the date format was defined as "yy-M'," dd" (excluding the double quotes) the date would be displayed as "04-1, 02".

### Time zones

The time zone of the computer used to configure a KeyTag is stored in the KeyTag's memory. In some cases, the configuration time zone will be different from the time zone at the download location. This allows you to select which time zone will be used to display dates and times within the chart, summary and data displays. This option will not have any effect on the original recorded data.

<table>
<thead>
<tr>
<th>Download Time Zone</th>
<th>All reading times are displayed in the time zone of the computer used for downloading/displaying the data. This is the default setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Time Zone</td>
<td>All reading times are displayed in the time zone of the computer used for configuring the KeyTag.</td>
</tr>
<tr>
<td>UTC/GMT Time Zone</td>
<td>All times are displayed in Universal Time Coordinates, or Greenwich Mean Time representation.</td>
</tr>
</tbody>
</table>
Communication Ports

The Communication Ports options control which communication ports are checked for connected Interface Cradles. This allows certain communication ports to be excluded, which are not used to connect Interface Cradles to and/or are regularly used for other applications, thereby reducing the possibility that this software will interfere with the operation of other applications running on the current system.

The software checks each communication port at the same time, rather than one after the other, therefore having the software check multiple communication ports will not adversely affect the performance of the software significantly. As the software supports multiple communication ports, it is possible to connect and use to more than one Interface Cradle at the same time.
The User Server options define if and where the software should connect to the KeyTag User Server software. If you do not have KeyTag User Server software installed on your computer and/or available on your local area network, you will not need to make any changes to this set of options. Connection to the KeyTag User Server software is typically only used within a multiple computer user environment and/or if your organization requires compliance with the US FDA 21 CFR Part 11 regulations, for use of digital signatures that are controlled by a central administrator.

You will need to consult your network administrator and/or documentation pertaining to the KeyTag User Server software to determine what settings should be used in this set of options. You will not be able to change these settings if the software is unable to establish a valid connection with the KeyTag User Server software.

Once a valid connection to the KeyTag User Server software has been established, you will be required to "log on" to the software to continue using it.
Software Updates

The KeyTag Analyzer software can periodically check to determine if a newer version of the program is available for download from the KeyLog Recorders website. This section allows the time interval, if enabled, between each check for a newer version to be defined. An interval of 30 days is recommended.

If the "Automatic Update" setting is enabled, KeyTag Analyzer will check and download a newer program version without further notification.
At the top of the screen for the KeyTag Analyzer, just below the title bar, which contains the name of the software, is the menu system and toolbar for the software. The toolbar provides quick access to some of the more commonly used functions within the menu system. The menu system contains lists of all the operations and commands that are available to you while using the software.

In This Chapter

Menu commands .................................................... 97
Toolbar commands ................................................. 105
Print preview toolbar .............................................. 106
Menu commands

The menu system has been separated into groups of related commands. Each of these menu groups is explained in more depth in the subsequent sections. The software will only display the menu groups and commands within each menu group that are appropriate depending on what you are currently doing with the software.

You may also see that some of the menu commands have a reference after the command name, for example F2 or Ctrl+O. These represent key strokes on the keyboard that instruct the software to perform the appropriate command, without the need to select the menu or toolbar command. When only one key reference is mentioned, for example “F2”, then pressing that single key on the keyboard will cause the appropriate command to be performed. If there is more than one key reference mentioned, for example Ctrl+O, then to cause the command to be performed you must press and hold down the first key mentioned while pressing the other key once. When letters are used in the key reference, for example Ctrl+O, it does not matter whether or not the caps lock is on or off.

In This Section

File Menu...............................................................98
Edit Menu ..............................................................101
KeyTag Menu.............................................................102
Window Menu ............................................................103
Help Menu..................................................................104
The "File" menu contains commands that generally relate to a KeyTag file as a whole. A KeyTag file contains a variety of information that relates to a data set representing readings that were recorded over a discrete period of time by a single KeyTag. The File menu will appear similar to the following picture.
The following table outlines the commands and the explanation of each command that may appear in the "File" menu when using the KeyTag Analyzer software:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| **Open...** | This will display the Open file dialog, which will allow you to open:  
  - KeyTag files that contain readings previously retrieved, or  
  - previously saved Multi Chart configuration files.  
  It will start at the folder defined in the *File and Folder Settings* section in the *Options*.  
  If a Multi Chart file is selected, the KeyTag Analyzer software will automatically switch to Multi Chart mode and all the selected files will be added to the Multi Chart display. |
<p>| Close     | This command will close all windows that are displaying information about the open file that is currently selected. If no files are currently open this command will not be visible.        |
| Multi Chart | This will change the way recordings are displayed such that they are all combined on a single chart window (see <em>Combining Charts into a single chart</em>).         |
| Single Chart | This will change the way recordings are displayed such that each which will contain all the information retrieved from a single KeyTag.                           |
| Save      | This will save any changes you have made to the KeyTag file (or Multi Chart configuration) to your disk drive.                                                                                           |
| Save As... | This will display the Save As file dialog, which will allow you to save a copy of the file currently being displayed in the same or different folder with the same or different file name. |
| <strong>Print...</strong> | This will open a window allowing you to print a copy of the KeyTag file to an output device, which will typically be a printer. This command is further explained in the section &quot;Printing the results&quot;. |
| Print Preview | This will change the display mode of the software to show you a copy of how a printout of the currently selected file and window would look like. In &quot;Print Preview&quot; mode you will not be able to zoom in or out of a chart. Click <strong>Close</strong> to exit the &quot;Print Preview&quot; mode and return to normal display mode. |
| Print Setup... | This will open a window allowing you to view and/or adjust one or more of your printer's settings.                                                                                                             |
| Page Setup... | This will open a window allowing you to view and/or adjust one or more of your page settings, like printer margins and page orientation.                                                             |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send</strong>...</td>
<td>This will help you send, by email, the currently open and selected KeyTag file to another user without the need to exit to your email software or to deal with file attachments. This command is explained in further detail in the section &quot;Sending a file by email direct from Analyser&quot;.</td>
</tr>
<tr>
<td><strong>Properties</strong>...</td>
<td>This will open a window that will display the information about the file that is being displayed and currently selected. This same window and information will be displayed if you view the properties of the file from Microsoft Windows Explorer.</td>
</tr>
<tr>
<td><strong>Digital Signature</strong>...</td>
<td>This will open a window to display a list of digital signatures that have been included with the file. It also allows you to add and print this list of digital signatures. This command is explained in further detail in the section &quot;Digital signatures&quot;.</td>
</tr>
<tr>
<td><strong>User logon</strong>...</td>
<td>This allows a user to logon to and use the Analyzer software. When the software is connected to the User Server software, users must logon to the software prior to being permitted to use the software. Therefore, this command will only be available if the Analyzer software is connected to the User Server software. If a user is already logged on to the software, then this command is not visible. The section &quot;User Server&quot; explains in more detail how to get the Analyzer software to connect to the User Server software.</td>
</tr>
<tr>
<td><strong>Logoff user</strong> (username)</td>
<td>This allows the currently logged on user to logoff the Analyzer software. The username portion of this command will represent the name of the user currently logged on. If there is no currently logged on user, this command is not visible.</td>
</tr>
<tr>
<td><strong>Change Password</strong>..</td>
<td>This allows the currently logged on user to modify their password that they use to logon to the Analyzer software. This command will only be available if the Analyzer software is connected to the User Server software and the User Server administrator has granted the appropriate user permissions.</td>
</tr>
<tr>
<td>1, 2, 3, etc</td>
<td>This portion of the menu represents a list of the most recently files you have viewed. To reopen one of these files, simply click on the entry (name of the file) to open. If a file that you want to view is not included in this list, you may use the &quot;Open...&quot; command included in this menu. The number of files included in this list can be adjusted through the &quot;General Settings&quot; section of the Options.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>This command will exit and close down the KeyTag Analyzer software. Any files that you currently have open will also be closed automatically for you. If a user is currently logged on to the Analyzer software when the Analyzer closes, the user will be automatically logged off.</td>
</tr>
</tbody>
</table>
Edit Menu

The "Edit" menu contains commands that generally relate to the contents of a KeyTag file and will appear similar to the following picture.

The following table outlines the commands and the explanation of each command that may appear in the "Edit" menu when using the KeyTag Analyzer software:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy (Ctrl+C)</td>
<td>Places a copy of the contents of the currently displayed window onto the clipboard, which can then be pasted into any Windows® application. If you are copying a chart, the chart at its current zoom range is copied to the clipboard. If you are copying from one of the tabular style windows (Data or Summary), then the entire contents of the window is copied to the clipboard, regardless of what part of the data you have scrolled to view.</td>
</tr>
<tr>
<td>Zoom Out ( )</td>
<td>This will undo the last zoom operation performed allowing you to see more of the data on the chart. If the chart is displaying all the readings recorded by the KeyTag, this command will not be available.</td>
</tr>
<tr>
<td>Zoom to Marks ( )</td>
<td>When this command is enabled, the chart is automatically zoomed to show readings recorded between inspection marks. The section &quot;Starting and using the KeyTag&quot; explains in further detail how inspection marks are recorded.</td>
</tr>
<tr>
<td>Previous group of Marks ( )</td>
<td>This command will show the readings recorded between the first inspection mark shown and the previous inspection mark recorded. This command will only be available if the &quot;Zoom to Marks&quot; command is enabled and the first reading recorded is not currently visible.</td>
</tr>
<tr>
<td>Next group of Marks ( )</td>
<td>This command will show the readings recorded between the last inspection mark shown and the next inspection mark recorded. This command will only be available if the &quot;Zoom to Marks&quot; command is enabled and the last reading recorded is not currently visible.</td>
</tr>
</tbody>
</table>
Options... ( ) This will open a window allowing you to customize the software. This command is further explained in the chapter "Customizing the software".

## KeyTag Menu

The "KeyTag" menu contains commands that generally relate to the usage and interaction with KeyTags.

The following table outlines the commands and the explanation of each command that may appear in the "KeyTag" menu when using the KeyTag Analyzer software:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure</strong>...</td>
<td>This will display a wizard to help you through the necessary steps to prepare KeyTags for their next use. This command is explained in further detail in the chapter &quot;Preparing KeyTags for use&quot;.</td>
</tr>
<tr>
<td><strong>Download</strong>...</td>
<td>This will display a wizard to help you through the necessary steps to retrieve a copy of the recorded readings stored within the KeyTag(s). This command is explained in further detail in the chapter &quot;Results from KeyTag&quot;.</td>
</tr>
<tr>
<td><strong>Hibernate</strong>...</td>
<td>This will display a wizard to help you through the necessary steps to set KeyTags to &quot;Hibernation&quot; mode. This command is explained further in the chapter &quot;Prolonging battery life&quot;.</td>
</tr>
<tr>
<td><strong>Wizard</strong>... ( )</td>
<td>This will display a wizard to help you through the necessary steps to retrieve a copy of the recorded readings stored within the KeyTag(s) and then prepare the KeyTags for their next use. This command is explained in further detail in the chapter &quot;Quick Start Guide&quot;.</td>
</tr>
</tbody>
</table>
Window Menu

The "Window" menu contains commands that relate to the management of each Window open within the KeyTag Analyzer software that displays the contents of a KeyTag file.

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
<td>Opens a new window that contains a copy of the information of the currently selected window. This command is useful when you need to closely inspect and analyze different sections of the same data set.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the currently selected window within the KeyTag Analyzer software.</td>
</tr>
<tr>
<td>Close All</td>
<td>Closes all the windows within the KeyTag Analyzer software.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Arrange all the windows within the KeyTag Analyzer software in an overlapping style.</td>
</tr>
<tr>
<td>Title Horizontally</td>
<td>Arrange all the windows within the KeyTag Analyzer software as horizontal non-overlapping tiles.</td>
</tr>
<tr>
<td>Title Vertically</td>
<td>Arrange all the windows within the KeyTag Analyzer software as vertical non-overlapping tiles.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arrange all the minimized windows within the KeyTag Analyzer software at the bottom of the main window.</td>
</tr>
<tr>
<td>1, 2, 3, etc</td>
<td>The tick mark beside these entries indicates the window that is currently selected. If you want to change the currently selected window to one of the windows listed, just click/select the appropriate entry on this list.</td>
</tr>
</tbody>
</table>
Help Menu

The "Help" menu contains commands that relate to providing you with help and assistance with using the KeyTag Analyzer software.

The following table outlines the commands and the explanation of each command that may appear in the "Help" menu when using the KeyTag Analyzer software:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics (epad)</td>
<td>Opens a window that contains the online help.</td>
</tr>
<tr>
<td>User Guide (a)</td>
<td>Opens the online user guide for viewing. Requires Adobe Acrobat and/or Adobe Acrobat Reader software, version 4 or later, to be installed on the computer.</td>
</tr>
<tr>
<td>KeyLog Recorders Home Page...</td>
<td>This will open your default Internet browser software and display the KeyLog Recorders Internet site, <a href="http://www.keylog.nl">www.keylog.nl</a>. This command requires that your computer be currently connected to the Internet to successfully display the KeyLog Recorders Internet site.</td>
</tr>
<tr>
<td>Request help... (8)</td>
<td>This will gather non personal information from your system to include in the email to be sent to software support at KeyLog Recorders, so that the support team will be informed of the relevant information about your system in order to provide you with quality and useful assistance. This command is explained in further detail in the chapter &quot;Getting more help&quot;.</td>
</tr>
<tr>
<td>Check Internet for update...</td>
<td>This is a simple way of checking to see if there is a newer version of this software available for download. This command is explained in further detail in the chapter &quot;Getting updated software&quot;.</td>
</tr>
<tr>
<td>About KeyTag Analyzer... (e)</td>
<td>Display the version information about the KeyTag Analyzer software that you are using.</td>
</tr>
</tbody>
</table>
Chapter 7  Menus and Toolbars  105

Toolbar commands

Each picture on the toolbar represents a unique command.

The pictures that are included on the toolbar represent the following commands:

This will bring up the KeyTag Wizard, which will take you through the steps to retrieve readings from connected KeyTag(s) and prepare them for their next use.

This will display the file open window to allow you to locate and open KeyTag files that contain previously retrieved KeyTag readings.

Save a copy of the KeyTag data to a file on your disk drive.

Opens the window that will allow you to print a copy of the KeyTag data to a printer.

Displays file properties about the currently selected open file.

Displays information about any digital signatures included in the currently selected open file, which is also allows where new digital signatures can be added to the file and where you can print a copy of the digital signatures.

Creates a new blank email for sending a copy of the currently selected open file as an attachment to a recipient of your choice.

Places a copy of the currently displayed information to the Windows clipboard so that you can paste it into another Windows software package.

Zooms out one level of the actively displayed chart. If you are displaying a chart and this function is not available, then all data that is available to be displayed is currently been displayed and therefore there is no more additional information that can be displayed by zooming out.

This zooms the chart to show information between the oldest reading recorded and the first inspection mark that exists amongst the data. If this function is not available then there is no inspection marks in the data currently been displayed. The next two commands will not be available until this command is activated.

This zooms the chart to show the group of data that was recorded between the previous inspection mark and the first inspection mark currently been displayed. This function is disabled when either the oldest reading is already been displayed or the chart has not been zoomed into showing groups of readings between inspection marks.
This zooms the chart to show the group of data that was recorded between the next inspection mark and the last inspection mark currently been displayed. This function is disabled when either the newest reading is already been displayed or the chart has not been zoomed into showing groups of readings between inspection marks.

Switches into Multi Chart mode, which displays all currently open charts together in one window. If additional KeyTag(s) are downloaded or more files opened, their data will be added to the Multi Chart window.

Switches into Multi Chart mode, with the average tabs active, or if already in multichart, activates or disables the average tabs. It is recommended to deactivate this feature when processing large data sets, as **Minimum, Maximum and Average Charts** (see "Special Chart Tabs" on page 57) can require considerable memory and processor resources when activated.

Switches into Single Chart mode. Each chart that is currently open will be displayed in its own window.

This will open a window allowing you to customize the software. This command is further explained in the chapter "**Customizing the software**".

This will log a user on to the software if no user is currently logged on or log off the currently logged on user. This command will only be available if the software is connected to the KeyTag User Server software.

This will allow you to show the help topic on any particular command or topic that you subsequently select.

---

**Print preview toolbar**

The print preview feature, available through the **File menu**, of the software will display copy of the data as it would be included on a print out. When the software is displaying a file in print preview mode, an additional toolbar will appear, similar to the following picture.

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print...</strong></td>
<td>This will open a window allowing you to print a copy of the KeyTag file to an output device, which will typically be a printer. This command is further explained in the section &quot;<strong>Printing the results</strong>&quot;.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Next Page</td>
<td>This will display the next page included in the print out. This button will be disabled if there are no more pages available to be displayed.</td>
</tr>
<tr>
<td>Prev Page</td>
<td>This will display the previous page included in the print out. This button will be disabled if there are no previous pages available to be displayed.</td>
</tr>
<tr>
<td>One Page</td>
<td>Selecting this button will change the display so that only one page is displayed at a time. Once this button is selected it will change to &quot;Two Page&quot;.</td>
</tr>
<tr>
<td>Two Page</td>
<td>Selecting this button will change the display so that two consecutive pages are displayed side by side at the same time. This button will be disabled if there is only one page in the print out, like a chart. Once this button is selected it will change to &quot;One Page&quot;.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>This will zoom in the display of the print out making it appear larger on the screen. It will not effect what information is included in the print out.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>This will zoom out the display of the print out making it appear smaller on the screen. It will not effect what information is included in the print out.</td>
</tr>
<tr>
<td>Close</td>
<td>This will close the print preview mode of display and revert the display of the data back to normal mode, which will allow users to switch between chart display and data listing display, for example.</td>
</tr>
</tbody>
</table>
When using and deploying software in a network environment, network administrators often require additional technical information about the software so they can integrate support for it correctly and seamlessly. This chapter briefly covers some points of interest for computer network administrators.

**In This Chapter**

- Distributing software to workstations ....................... 108
- Restricting what users can do ................................. 109
- How users log on ................................................... 110
- How users change their password ........................... 111

---

**Distributing software to workstations**

When using the software on many computers within a computer network, it is not always efficient to visit and install the software and subsequent updates manually on each computer workstation. The installation of the software does support zero administration installation, whereby the installation package can be located on a central point, usually a server, and have it install on each relevant workstation, without requiring user intervention.

To distribute the software without user intervention is a two step process.

1. Create an installation script file that will provide the answers and actions to be performed on each step of the installation process. To create an installation script, use the following command line syntax, including the quotes as used:

   \myserver\my_apps_path\setup.exe /a /r /f1"\myserver\my_apps_path\setup.iss"

2. Ensure that whenever a user installs the software the installation script is used. To install the software using an installation script previously created use the following command line:

   \myserver\my_apps_path\setup.exe /s /a /s /f1"\myserver\my_apps_path\setup.iss"

Where,

- **a** "\myserver\my_apps_path" represents the network path to the folder containing the installation of the KeyTag Analyzer software.
- **b** "setup.exe" is the installation software.
As many different installation scripts as are suitable for your situation may be defined and used.

KeyTag Analyzer software is released on the KeyLog Recorders Internet site using a standard filename syntax, which is 
[software_name][major_version][minor_version][release_version].exe. For example, if the file name of the installation package was "keytag_analyser_10r24.exe" the name of the software would be "KeyTag Analyzer" version 1.0 Release 24.

The installation of the KeyTag Analyzer software involves copying a number of files to the destination folder, which can be chosen during the installation process, a file is installed in the Windows System folder and some plug and play drivers to support the USB Interface Cradle. Therefore, when deploying the software onto Windows NT® based operating systems, like Windows NT®, Windows 2000® and Windows XP®, the user installing the software will require local administrator privileges for the software to install correctly. It is possible, to elevate a users permissions on a Windows NT® based server network for the sole purpose of being able to install the software successfully through the use of a Group Policy Object.

When installing the software on to a Windows NT® operating system, the plug and play drivers for the USB Interface Cradle will not be installed as Windows NT® does not support USB devices.

---

### Restricting what users can do

In a multiple user environment, it is not always desirable to allow every user to perform any and all tasks with the software. For example, to ensure all documents printed from the software use the same date/time display format, it may be desirable to not allow users to customize the software to change how the software displays dates and times. To provide administrators of systems with a central point of control, KeyLog Recorders has developed a software package called "KeyTag User Server", which when used in conjunction with this software, it will provide an administrator with the ability to choose whether or not to restrict what users can and cannot do with this software.

To find out more about KeyTag User Server, please contact your network administrator and/or your KeyTag reseller.
How users log on

When the software has been *customized* to be connected to the *KeyTag User Server* software, all users are required to successfully logon to the software before being permitted to use any of the features and functionality of the software. For a user to successfully logon to the software, the user must enter their username, which the administrator would have assigned, and their password. Username's are typically not case sensitive, however passwords are. That is, entering the Username "Bob Smith" is the same as entering "BOB SMITH" and "bob smith". However, entering a password of "bob" rather than "Bob", for example, is considered to be different.

Every logon attempt, whether successful or not, may be recorded automatically in the audit logs by the administrator. As a security measure, the network administrator may configure the *KeyTag User Server* software so that a user account becomes locked and therefore temporarily inaccessible if a certain number of consecutive failed logon attempts are made to the user account. Please contact your network administrator if you have problems with the logging on the software.
How users change their password

When the software has been customized to be connected to the KeyTag User Server software, the network administrator may require and/or permit users to change the password used to logon to the software. Users are only permitted to change the password for the user account that is currently logged on, which is typically their own, and as a security precaution, users will always need to supply their current logon password before being permitted to change it.

The network administrator may enforce certain rules pertaining to what is a valid password. For example, they may require a minimum number of characters (digits, letters or symbols) and/or a minimum number of digits to be included in the password. Please contact your network administrator if you have problems with the logging on the software.

Passwords should be chosen such that they would be difficult for some one else to guess. If another person was able to guess the password they would be able to logon and impersonate the user. Therefore, following are a few points to remember when changing a password:

1. Do not use something that is personal to the user. Birth dates, license plate numbers, names of family members, types of vehicles owned, favorite foods and address of residence are all examples of passwords that should NOT be used.

2. Do not write it down.

3. Change the password on a regular basis.

If a user's password is forgotten, the network administrator will be able to change it. However, network administrators will not be able to see and therefore inform users what their current password is.
In This Chapter

Getting updated software ....................................... 112
Finding your software version ................................. 114
Getting more help .................................................. 115

Getting updated software

There are two ways to see if a newer version of the KeyTag Analyzer software is available and download a copy if a newer version exists.

1. Within the "Help" menu item in the software is a command called "Check Internet for update..."

2. Visit the KeyLog Recorders Internet Site, www.keylog.nl, and follow the relevant instructions to obtain a copy of the software.
The first option will download from the KeyLog Recorders Internet site the relevant information about the latest version of the software available and compare this information with the software that has already been installed. The software will then let you know whether or not a newer version of the software is available. During this entire process no information about you or your system is transmitted out from the KeyTag Analyzer software and therefore you can rest assured that your privacy is maintained.

While the software is retrieving the information from the Internet about the latest available version, the software will display its progress in a window similar to the following picture.

![Check for Update](image)

Checking software version available on web site against your already installed software.

If a newer version of KeyTag Analyzer is available a "Download" button will appear. Clicking "Download" will begin the download process, in which you select the location for the installation file. After the installation file has been downloaded you will need to close KeyTag Analyzer and then start (open) the downloaded file to begin the installation.

Installing a newer version of the KeyTag Analyzer software will update all the relevant program files. It will not affect any of your KeyTag data files or your custom settings of the software. Software updates usually include feature enhancements and/or resolve problems discovered with the software subsequent to its release. We recommend you use the latest version of the KeyTag Analyzer software available.

KeyTag Analyzer can automatically check if a newer software version is available. The interval between automatic checks for an update can be specified through the Updates section from within the Options Window.
Finding your software version

Within the "Help" menu, is the "About KeyTag Analyzer..." command, which will display a Window similar to the following picture.

![About KeyTag Analyzer Window](image)

Within this window, amongst other information, the full version number of the software being used is displayed. This information is useful, for example, to determine if the same software version is installed on multiple computers and/or if the user guide being referenced refers to the version of software being used.

For example, if the window shows the software to be "KeyTag Analyzer 1.7" and the version of this guide is 1.7, then the contents of this user guide refer to the version of software being used. If however, this window shows the software to be "KeyTag Analyzer 1.0" and the version of this guide is 1.7, then this version of the user guide does not refer to the version of the software being used. The version of this guide is 1.7, which is also shown on the cover page of the guide.

Each time the software is updated one part of the version number of the software is always increased. The "Build" number portion is increased for a given version of the KeyTag Analyzer software when the change included in the software will not affect the matching version of the user guide. For example, version 1.7 of the guide refers to both the "KeyTag Analyzer, Version 1.7 Build 2" and the "KeyTag Analyzer, Version 1.7 Build 5" of the software.
Getting more help

The time may arise when this guide is unable to provide you with the assistance you require. The KeyTag Analyzer software includes a way to make the process of getting further assistance from KeyLog Recorders as simple as possible, while providing the support team at KeyLog Recorders with enough information about your system to be able to provide you with useful assistance. Within the "Help" menu of the software is a "Request help..." command.

This command will gather non personal information from your system to include in the email, which you can review if you want to, so that KeyLog Recorders will be informed of the relevant information about your system in order to provide you with quality and useful assistance. Please include in the email as much information and detail about the problem that you are experiencing with the KeyTag Analyzer software as possible, even if you may think it to be irrelevant, as the more information that is available the more likely KeyLog Recorders will be able to provide you with an appropriate solution quickly.

If you have suggestions for software improvements, you may also use this method to send your ideas through as KeyLog Recorders is always in the process of improving the software and adding additional features to it, so that the software becomes increasingly more efficient, effective and useful for users.
In This Chapter

Troubleshooting ..................................................... 116
Finding your computer specifications ....................... 118
Resolving USB Driver Problems ............................... 124
Sensor Responsiveness ........................................... 147

Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| My KeyTag appears to be “dead”. No lights are flashing. | This could represent either of two conditions: 

1. The KeyTag is ready to start, but has not been started yet. 

2. The KeyTag is simply in a state where the configuration has the LED flashing turned off. This is an option that may be selected when a KeyTag has been shipped to the user for the first time (to preserve battery life) or it may be that the last configuration setting selected no LED display. 

3. The KeyTag is in "Hibernation" mode. Refer to "Prolonging battery life" for further information. 

4. The battery is dead and the KeyTag is expired. |

How to test: 

1. Try pressing the START MARK button on the KeyTag. 

2. Start the KeyTag Analyzer software and place the KeyTag into the Interface Cradle. Download the KeyTag. If the KeyTag can be identified by the software, then the battery is good, and the KeyTag is OK. |
<table>
<thead>
<tr>
<th>I am unable to get a serial port “free”. Every time I run the software, every port shows that is already in use</th>
<th>On rare occasions it may be difficult to configure some computers for releasing the assignment of a serial port from one application to another. Often, this will require the services of a computer technician or expert. One simple solution is to purchase a USB Interface Cradle. USB connections do not have a “free port” limitation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>What happens if there is an electrical current between the contacts...will that damage the KeyTag?</td>
<td>The contacts are isolated from the critical internal component such that incidental static discharge will not harm the KeyTag. Deliberate application of a full outlet voltage (100 – 240 volts AC or 12-24 volts DC) to the KeyTag may cause permanent damage.</td>
</tr>
<tr>
<td>I cannot view the user guide that came with the software.</td>
<td>The User Guide is in a 'PDF' file format and as such a special software package called &quot;Acrobat Reader&quot; is required to view it. Acrobat Reader is available for free download from the Adobe web site and can typically be downloaded from <a href="http://www.adobe.com/products/acrobat/readermain.html">http://www.adobe.com/products/acrobat/readermain.html</a>.</td>
</tr>
<tr>
<td>I cannot see all the readings in the &quot;data&quot; screen, some appear to be missing.</td>
<td>The range of readings shown in the data screen represent the range of readings shown on the Chart screen. Whenever the Chart is zoomed in to show more detail the range of readings shown in the data screen is updated as well. If the chart is zoomed out (Zoom out) to show all readings that were recorded, then the data screen will also show all the readings that were recorded.</td>
</tr>
<tr>
<td>Why are some of the readings shown &quot;non validated&quot;.</td>
<td>The KeyTag automatically inserts error detection codes every 127 recordings which checks for the detection of corrupted or manipulated data. If the KeyTag has been configured to do continuous recording then as each block of 127 logs is started to be replaced with the latest readings the data integrity error check for the &quot;oldest&quot; block will fail, which will therefore technically putting the block of data into doubt. This is not a problem rather that the particular block of data now has the lost a degree of data integrity protection and hence is labelled 'non-validated'. Non-validated readings can also occur if there has been communications issues during data transfer from the KeyTag or if the memory does actually have a fault, however these causes are very rare.</td>
</tr>
</tbody>
</table>

If above suggestions are insufficient, please check the website at www.keylog.nl for more information, specifically the FAQ section.
Finding your computer specifications

If you are unsure of your computer specifications you can find the relevant information by following these steps:

1. To determine your computer CPU, RAM and version of Windows Operating system:

   a) Open the "Control Panel". This can be done by using the mouse to click on the Windows "Start" button, typically located in the bottom left of the screen, to open the Start menu.

   b) Once the "Start" button has been clicked, you will see a menu appear.

   c) If your menu looks similar to the following picture, click on the visible "Control Panel" item.
d) If your menu looks similar to the following picture, the "Control Panel" item is located within the "Settings" menu item.

![Control Panel menu](image)

e) Within the "Control Panel" window there is a "System" icon. For Windows XP users, you may need to "Switch to Classic View" to locate the "System" icon quickly. Start (open) the "System" icon once you have located it.
f) Clicking on the "General" tab at the top of the "System Properties" window, which is usually the default, will display the relevant information for you about your system.

2 To determine your screen resolution and colors:
   a) Open the "Control Panel" as explained in step 1.
   b) Open the "Display" item.
   c) Click on the "Settings" tab at the top of the "Display Properties" window will display the relevant information for you about your display.
d) From the "Settings" portion of the "Display Properties" window you will see your current screen settings and you may also be able to change some of your display settings if you want.

3 To determine your spare hard disk drive space:
   a) Open "My Computer" which is typically located on your desktop and/or within the Windows "Start" menu.
b) Using your mouse, click the button on the right over the drive that includes "(C:)" in its description.

![My Computer window with drive selection](image)

- **System Tasks**
  - View system information
  - Add or remove programs
  - Change a setting

- **Other Places**
  - My Network Places
  - My Documents
  - Shared Documents
  - Control Panel

- **Details**
  - My Computer
  - System Folder

**Files Stored on This Computer**
- Shared Documents
- username's Documents

**Hard Disk Drives**
- Local Disk (C:)

**Devices with Removable Storage**
- 3½ Floppy (A:)
- DVD Drive (D:)

**Network Drives**

---

c) Select "Properties" (left mouse click) from the popup menu that will appear.
d) Clicking on the "General" tab at the top of the drive properties window will display the relevant information for you about your hard drive.

![Local Disk (C:) Properties window]

- **Type:** Local Disk
- **File system:** NTFS
- **Used space:** 2,334,171,136 bytes (2.17 GB)
- **Free space:** 14,831,951,872 bytes (13.8 GB)
- **Capacity:** 17,166,123,008 bytes (15.9 GB)
- **Drive C**
- **Disk Cleanup**
- **Compress drive to save disk space** (unchecked)
- **Allow Indexing Service to index this disk for fast file searching** (checked)

![Drive C Properties]

e) If you have multiple (hard disk) drives installed on your computer you can repeat steps (b) through to (d) for each drive to get the same type of information.
Resolving USB Driver Problems

Every USB device requires the appropriate driver files to be installed prior to them being successfully used on a computer. The installation process of the KeyTag Analyzer software will attempt to ensure the appropriate driver files are installed on the computer. These driver files may fail to install correctly if the USB Interface Cradle is connected to the computer prior to and/or during to the installation of the software. Therefore, it is strongly recommended that the software is installed prior to any USB Interface Cradles being connected to the computer.

The following sections will guide you through the steps necessary to determine whether or not a problem exists with the installation of the USB drivers for the USB Interface Cradle are installed correctly on the computer and, if necessary, how you can resolve a problem with the installation of the USB drivers.

In This Section

Checking the installation of the USB driver .................. 124
USB driver installation through software installation .130
Manual USB driver installation on Windows XP .......... 132
Manual USB driver installation on Windows 2000....... 136
Manual USB driver installation on Windows 98 or Me 142

Checking the installation of the USB driver

The following will guide you through the steps necessary to determine whether or not the drivers for the USB Interface Cradle are installed correctly on the computer.

1  Providing the KeyTag Analyzer software has been already installed, connect the USB Interface Cradle to the computer by plugging the Interface into an available USB socket. USB sockets are typically located at the rear of the computer.

2  Open the "Control Panel". This can be done by using the mouse to click on the Windows "Start" button, typically located in the bottom left of the screen, to open the Start menu. Once the "Start" button has been clicked, you will see a menu appear.
3 If your menu looks similar to the following picture, click on the visible "Control Panel" item.
4 If your menu looks similar to the following picture, the "Control Panel" item is located within the "Settings" menu item.

5 Within the "Control Panel" window there is a "System" icon. For Windows XP users, you may need to "Switch to Classic View" to locate the "System" icon quickly. Start (open) the "System" icon once you have located it.
If your system properties looks similar to the following picture, click the "Hardware" tab followed by the "Device Manager" button to open a view of the devices that have and have not been successfully installed on the computer.
7 If your system properties look similar to the following picture, click the "Device Manager" tab to view the devices that have and have not been successfully installed on the computer.

![System Properties](image)

- View devices by type
- View devices by connection

- Computer
  - CDROM
  - Disk drives
  - Display adapters
  - Floppy disk controllers
  - Hard disk controllers
  - Keyboard
  - Monitors
  - Mouse
  - Network adapters
  - Ports (COM & LPT)
  - Sound, video and game controllers
  - System devices
  - Universal Serial Bus controllers
Once the device manager is open you should see one of the three following images in the list, as indicated in the following picture. You may need to click on the "+" beside the "Universal Serial Bus controllers" entry to view all the USB devices that have been installed on the computer.

If the USB device driver installed successfully but has not yet started, the following will guide you through steps necessary to start the USB drivers so that you can start using the USB Interface Cradle(s).

If the computer is using Windows XP or Windows 2000:

1 Open the "Device Manager" as described previously.
2 For each "USB Interface" entry displayed, using the mouse (pointing device), click the right button on the text of the "USB Interface" entry to display the popup context menu, which will be similar to the following picture. Once this pop context menu is visible, select the "Uninstall" option, using the left button on the mouse.

3 Unplug all USB Interface Cradles that are plugged into the computer and/or are plugged into any USB hub that may be connected to the computer.

4 Wait for at least 5 seconds.

5 Plug the USB Interface Cradle(s) into the appropriate USB socket on the computer and/or USB hub that is connected to the computer. This should install and start the USB driver for the USB Interface Cradle(s). If the drivers do not successfully start, indicated by the "USB Interface" entry appearing in the device manager with either the or the picture, you may need to reinstall the USB driver files, which is described subsequently.

If the USB device driver files did not install correctly, you may either reinstall the software or manually install the USB driver files. This set of USB drivers was first released with the KeyTag Analyzer software version 1.7. If you have a version of the software prior to this, get a copy of the latest version of the KeyTag Analyzer software and install the latest version of the software ensuring all USB Interface Cradles are not connected to the computer during the installation process.

**USB driver installation through software installation**

To reinstall the software to install the USB drivers:

1 Unplug all USB Interface Cradle(s) that are connected to the computer and/or connected to a USB hub that is connected to the computer.

2 Start the Windows "Control Panel"
3 Within the "Control Panel" window there is a "Add/Remove Programs" or "Add or Remove Software" icon. For Windows XP users, you may need to "Switch to Classic View" to locate the "Add or Remove Software" icon quickly. Start (open) the "Add or Remove Software" icon once you have located it.

4 Locate the "KeyTag Analyzer" entry and click the "Change/Remove" or "Add/Remove..." button.

5 Once the "KeyTag Analyzer Setup Maintenance" window is open, select the "Repair" option and then click the "Next >" button.

6 Click the "Finish" button when it is displayed to complete the reinstallation of the software and USB driver files.

Note, if you see a window similar to the following picture appear during the installation of the USB driver files, you must click the "Continue Anyway" button for the USB driver files to successfully install.

![Hardware Installation](image)
Manual USB driver installation on Windows XP

To manually reinstall the USB driver files, for Windows XP computers, open the "Device Manager". The "Device Manager" can be started by opening the "System" icon, located in the Windows "Control Panel", selecting the "Hardware" tab in the "System Properties" window and then click the "Device Manager" button.
1. Using the mouse (pointing device), click the right button to display the popup context menu, which will be similar to the following picture.

![Device Manager](image)

2. Select the "Update Driver..." option, using the left button on the mouse, which will cause the device driver wizard to start, similar to the following picture. Ensure the "Install from a list or specific location (Advanced)" option and then click the "Next >" button to continue.

![Hardware Update Wizard](image)
When prompted for the location of the driver files, enter the location of the installation of the software followed by the path to the USB driver files. The default location for these driver files is "C:\Program Files\KeyLog Recorders\KeyTag Analyzer\Drivers\USB Interface 2.0". You may use the "Browse..." button in the window that appears, similar to the following picture to help you locate the appropriate folder.

![Hardware Update Wizard](image)
4 Once the driver files have been installed successfully you will see a window similar to the following picture. You may now connect and start using your USB Interface Cradle(s).

**Hardware Update Wizard**

**Completing the Hardware Update Wizard**

The wizard has finished installing the software for:

- USB Interface

Click Finish to close the wizard.

Note, if you see a window similar to the following picture appear during the installation of the USB driver files, you must click the "Continue Anyway" button for the USB driver files to successfully install.

**Hardware Installation**

The software you are installing for this hardware:

- Universal Serial Bus controllers

has not passed Windows Logo testing to verify its compatibility with Windows XP. (Tell me why this testing is important.)

Continuing your installation of this software may impair or destabilize the correct operation of your system either immediately or in the future. Microsoft strongly recommends that you stop this installation now and contact the hardware vendor for software that has passed Windows Logo testing.

[Continue Anyway] [STOP installation]
To manually reinstall the USB driver files, for Windows 2000 computers, open the "Device Manager". The "Device Manager" can be started by opening the "System" icon, located in the Windows "Control Panel", selecting the "Hardware" tab in the "System Properties" window and then click the "Device Manager" button.
1. Using the mouse (pointing device), click the right button to display the popup context menu, which will be similar to the following picture.

2. Select the "Properties..." option, using the left button on the mouse.

3. From the "USB Interface Properties" window that will appear, similar to the following picture, click the "Reinstall Driver..." button.
4 The will device driver wizard will appear similar to the following picture, click the "Next >" button to continue.

5 Ensure the "Search for a suitable driver for my device (recommended)" option is selected and click the "Next >" button to continue.
6 Ensure the "Specify a location" option is selected and click the "Next >" button to continue. It is best that the "Specify a location" option is the only one selected for the installation of the USB Interface Cradle driver files.

![Driver Installation Wizard](image)

7 When prompted for the location of the driver files, enter the location of the installation of the software followed by the path to the USB driver files. The default location for these driver files is "C:\Program Files\KeyLog Recorders\KeyTag Analyzer\Drivers\USB Interface 2.0". You may use the "Browse..." button in the window that appears, similar to the following picture to help you locate the appropriate folder.

![Driver Installation Wizard](image)
If you have chosen the correct folder that contains the driver files for the USB Interface Cradle, you will see a window similar to the following picture. Click the "Next >" button to install the driver files.

Once the driver files have been installed successfully you will see a window similar to the following picture. You may now connect and start using your USB Interface Cradle(s).
Note, if you see a window similar to the following picture appear during the installation of the USB driver files, you must click the "Continue Anyway" button for the USB driver files to successfully install.

![Hardware Installation](image)

The software you are installing for this hardware:

Universal Serial Bus controllers

has not passed Windows Logo testing to verify its compatibility with Windows XP. ([Tell me why this testing is important.](#)

Continuing your installation of this software may impair or destabilize the correct operation of your system either immediately or in the future. Microsoft strongly recommends that you stop this installation now and contact the hardware vendor for software that has passed Windows Logo testing.
Manual USB driver installation on Windows 98 or Me

To manually reinstall the USB driver files, for Windows 98 and Me computers, open the “System” icon in the Windows “Control Panel” and select the “Device Manager” tab.

1. Select the “USB Interface” item that is listed in the “Other devices” group, similar to the following picture.
2 Click the "Properties" button to display the driver.

![USB Interface Properties](image)

Click the "Reinstall Driver" button to begin the device driver wizard. Click the "Next >" button to continue.

3 Click the "Reinstall Driver" button to begin the device driver wizard. Click the "Next >" button to continue.
4. Ensure the "Search for a better driver than the one your device is using now. (Recommended)" option is selected and click the "Next >" button to continue.

5. When prompted for the location of the driver files, enter the location of the installation of the software followed by the path to the USB driver files. The default location for these driver files is "C:\Program Files\KeyLog Recorders\KeyTag Analyzer\Drivers\USB Interface 2.0". You may use the "Browse..." button in the window that appears, similar to the following picture to help you locate the appropriate folder.
6 If you have chosen the correct folder that contains the driver files for the USB Interface Cradle, you will see a window similar to the following picture. Click the "Next >" button to install the driver files.

![Update Device Driver Wizard](image)

Windows driver file search for the device:

USB Interface

Windows is now ready to install the best driver for this device. Click Back to select a different driver, or click Next to continue.

Location of driver:

C:\PROGRA~1\KEYLOG~1\KEYTAG~2\DR

7 Once the driver files have been installed successfully you will see a window similar to the following picture. You may now connect and start using your USB Interface Cradle(s).

![Update Device Driver Wizard](image)

USB Interface

Windows has finished installing an updated driver for your hardware device.
Note, if you see a window similar to the following picture appear during the installation of the USB driver files, you must click the "Continue Anyway" button for the USB driver files to successfully install.

**Hardware Installation**

The software you are installing for this hardware:

Universal Serial Bus controllers

has not passed Windows Logo testing to verify its compatibility with Windows XP. (Tell me why this testing is important.)

*Continuing your installation of this software may impair or destabilize the correct operation of your system either immediately or in the future. Microsoft strongly recommends that you stop this installation now and contact the hardware vendor for software that has passed Windows Logo testing.*

[Continue Anyway] [STOP Installation]
Sensor Responsiveness

Temperature sensors typically respond to changes in the environment temperature in a logarithmic way and as such you will find that the responsiveness of temperature sensors (how quickly a sensor responds to an environmental temperature change) is expressed in terms of T90. T90 represents the time it takes for a logger to respond to 90% of the actual change of the environmental temperature.

For example, if the actual environment temperature suddenly changed from 15° to 45° and the T90 of the sensor was 30 minutes, then 30 minutes after this sudden change the sensor would be reading \((15 + (45 - 15) \times 0.90)\) 42°. In reality, it is rare for the temperature of an environment to suddenly change to a very different temperature and then suddenly change again, usually it is a gradual incremental process.

For example, if the actual environment temperature changed from 15° to 45° over a period of 5 hours in a linear fashion, that is after 2 hours the temperature was 27° and after 4 hours the temperature was 39°, and the T90 of the sensor was 30 minutes, then when after 5 hours of this temperature change, that is the actual environment temperature was 45°, the sensor would be reading 44.7°.

KeyTag products are designed to produce rapid response to environmental changes. For example, the KTL-8 model achieves a rapid response to temperature changes because the actual sensor element is external to the logger body itself. The T90 of the KeyTag KTL-8 is typically less than 5 minutes in moving air, which is very responsive as some internal sensor temperature recorders can take up to an hour for the T90 of the temperature change to be recorded.
Index

A
Alert Processing • 31
Aligning Charts • 57, 61
Appendix • 117
Automatically calculated statistics • 62
Automation • 76, 83
Average Reading • 62

C
Calling up previous results • 69, 100
Changing Chart Colours • 56
Chapter Template • 54, 56, 59, 68, 76,
  100, 101, 103, 107, 111, 112, 114
Chart annotations • 49
Chart Statistics • 54, 66, 76, 80
Chart subtitle • 51
Charts • 48, 54, 56, 57, 59, 76, 81
Checking the installation of the USB driver • 125
Combining charts onto a single chart • 53,
  61, 83, 100
Communication Ports • 18, 76, 94
Configure KeyTag(s) for next use • 19
Connecting the Interface • 12
Continuous operation • 29, 35, 118

D
Dates and Times • 76, 88, 91
Degree Minutes • 65
Digital signatures • 71, 101
Display • 85
Display readings after successful download • 84
Display X items in my most recently used list • 85
Displaying statistics • 66
Distributing software to workstations • 109

E
Edit Menu • 47, 48, 102
Enable automatic download of readings from KeyTags • 84
Exports and Reports • 68, 76, 89

F
File and Folder Settings • 76, 84, 85, 90,
  100
File Menu • 50, 52, 61, 69, 74, 85, 99, 107
File Name • 86
Finding your computer specifications • 6,
  119
Finding your software version • 4, 105,
  115
Folder • 88

G
General Settings • 76, 77, 101
Get a KeyTag ready for use • 15, 103
Getting a copy of the software • 7
Getting a KeyTag ready for use • 26, 103
Getting more help • 105, 116
Getting more information • 113
Getting results from KeyTag • 42, 103
Getting the best from your KeyTag • 37
Getting updated software • 4, 70, 105,
  113

H
Help Menu • 105, 115
How secure is my data • 72, 82
How users change their password • 101,
  112
How users log on • 95, 101, 111

I
Inspecting the information at close range • 44
Installing the software • 5
Introduction • 4

K
KeyTag Menu • 103

L
Language • 78
Locate KeyTag(s) download and save relevant data • 17
Index

M
Manual scaling of the chart • 48
Manual USB driver installation on Windows 2000 • 136
Manual USB driver installation on Windows 98 or Me • 142
Manual USB driver installation on Windows XP • 132
Mean Kinetic Temperature • 64
Menu commands • 98
Menus and Toolbars • 15, 67, 68, 69, 71, 97
Minimum, Maximum and Average Charts • 57

O
Only show the latest set of readings after download • 84

P
Page Setup • 99
Prepare KeyTag(s) for next use • 20
Preparing KeyTag for next use • 28
Preparing KeyTag(s) for use • 19, 21, 25, 34, 38, 103
Pre-start data collection • 29, 35, 44
Print preview toolbar • 100, 107
Printing the results • 67, 100, 107
Prolonging battery life • 38, 103, 117

Q
Quick Start Guide • 12, 103

R
Resolving USB Driver Problems • 8, 13, 125
Restricted Access Requirements • 27, 30
Restricting what users can do • 110
Results from KeyTag • 24, 41, 103
Retrieve information from KeyTag • 23

S
Saving a Multi Chart file • 61
Sending a file by e-mail direct from
Analyser • 68, 90, 101
Sensor Responsiveness • 147
Shifting chart start times • 54
Show temperatures in • 78
Software Updates • 96, 114
Special Chart Tabs • 54, 57, 107
Standard Deviation • 63
Starting and using the KeyTag • 21, 102
Starting the software • 9
Summary Statistics • 66, 76, 79
System requirements • 6

T
The installation process • 8
Toolbar commands • 47, 48, 106
Troubleshooting • 117

U
Understanding the results • 43
Uniqueness • 88
USB driver installation through software installation • 130
Use Font • 78
User Server • 71, 76, 95, 101, 111, 112
Using the KeyTag with the Interface • 14

V
Verify Access Password • 30, 34
Viewing file properties • 74, 101

W
Welcome • 16
Window Menu • 104
Working with batches of KeyTags • 36
Working with Networks • 109